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User Guide for Cisco Unified
OL-12230-01
C H A P T E R 1

Logging In to Cisco Unified 
MeetingPlace Express

Note For information about accessing the Cisco Unified MeetingPlace Express 
meeting room from within a Cisco Unified Personal Communicator voice or 
video meeting, see the online help for the Cisco Unified Personal Communicator 
system.

 • About Your Profile, page 1-1

 • Logging In Through the Web, page 1-4

About Your Profile
Your Cisco Unified MeetingPlace Express profile contains all of your contact and 
access information such as your user IDs and passwords, contact information, and 
privileges. Generally, as a profiled user who has logged in, you can access all 
features unless your system administrator has set your profile with restrictions.

You may be able to change some information in your profile. For details, see 
Chapter 15, “Changing Your Cisco Unified MeetingPlace Express Preferences.” 
If you want to change other information or restrictions in your profile, contact 
your system administrator.

 • Features Restricted to Profiled Users, page 1-2

 • Your User IDs and Passwords, page 1-2
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Chapter 1      Logging In to Cisco Unified MeetingPlace Express
    About Your Profile
 • User ID and Password Information for Former Users of 
Cisco Conference Connection or Cisco Unified Communications Manager, 
page 1-3

Features Restricted to Profiled Users
You can only user the following features if you are a profiled user who is logged 
in to Cisco Unified MeetingPlace Express:

 • Schedule or start a meeting.

 • Find a meeting that is not published without knowing the meeting ID.

 • Perform meeting- and participant-management operations in the 
web meeting room during a meeting.

 • End a meeting from the phone interface.

 • Change your profile settings.

If you do not log in, you can only access features that are available to guest users, 
even if you are a Cisco Unified MeetingPlace Express profiled user.

Your User IDs and Passwords
Every Cisco Unified MeetingPlace Express profiled user has two user IDs and 
their associated passwords. Your system administrator will tell you these 
passwords.

When Logging In Through Use This ID and Password

Cisco Unified MeetingPlace Express 
web pages

Username and associated password

Touch-tone telephone

Cisco Unified MeetingPlace Express 
Phone View on your Cisco Unified IP 
Phone

Phone profile number and associated 
phone profile password
1-2
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Chapter 1      Logging In to Cisco Unified MeetingPlace Express
    About Your Profile
Related Topics

 • Password Restrictions, page A-1

User ID and Password Information for Former Users of 
Cisco Conference Connection or Cisco Unified Communications 
Manager

Note In earlier releases of this documentation, Cisco Unified Communications 
Manager was called Cisco Unified CallManager.

If your organization migrated to Cisco Unified MeetingPlace Express from Cisco 
Conference Connection and uses Cisco Unified Communications Manager to 
manage user profiles, see the following table for your default user profile values: 

Cisco MeetingPlace Express Field Updated Value

Username Your Cisco Unified Communications 
Manager user ID

Password for username Your Cisco Unified Communications 
Manager password

Phone profile number Your Cisco Unified Communications 
Manager phone number.

Note If your Cisco Unified 
Communications Manager 
phone number is not unique in 
the list of Cisco Unified 
MeetingPlace Express phone 
profile numbers, the system 
will assign a different, unique 
phone profile number for you.

Password for phone profile Your Cisco Unified Communications 
Manager PIN.
1-3
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Chapter 1      Logging In to Cisco Unified MeetingPlace Express
    Logging In Through the Web
Logging In Through the Web
There are three ways to log in to Cisco Unified MeetingPlace Express as a 
profiled user:

 • Click the Meeting ID link in your e-mailed meeting notification.

 • Dial the phone number of your Cisco Unified MeetingPlace Express server 
and follow the prompts. 

 • Open a web browser and log in through the Cisco Unified 
MeetingPlace Express web page.

This topic describes how to log in as a profiled user from the Web.

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • If you do not have a profile, you cannot log in to the system. See the “Finding 
a Meeting or Recording” section on page 4-1 or the “How to Join a Meeting” 
section on page 5-3 instead.

Procedure

Step 1 Open a web browser and enter the URL for your Cisco Unified 
MeetingPlace Express system.

Step 2 Enter your Cisco Unified MeetingPlace Express username and password. 

 • If you do not see these fields, click Log In at the top of the page.

 • These values are case-sensitive.

Step 3 Check Remember Me if you want to sign in automatically each time you use the 
system. 

For better security, do not check this check box.

Step 4 Click Log In.

The page refreshes with your name at the top right of the page.
1-4
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Chapter 1      Logging In to Cisco Unified MeetingPlace Express
    Logging In Through the Web
Troubleshooting Tips

 • If you try to log in multiple times but cannot, you may have reached the 
maximum number of unsuccessful log-in attempts. Contact your 
Cisco Unified MeetingPlace Express system administrator to unlock your 
profile.

 • If you cannot remember your password, contact your system administrator.

Related Topics

 • Your User IDs and Passwords, page 1-2

 • How to Resolve Log In Problems, page 16-2

 • Password Restrictions, page A-1
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User Guide for Cisco Unified
OL-12230-01
C H A P T E R 2

Scheduling a Cisco Unified 
MeetingPlace Express Meeting

 • Tips for Scheduling Secure Meetings, page 2-1

 • How to Start a Meeting Right Away, page 2-2

 • How to Schedule a Meeting, page 2-6

 • How to Schedule a Meeting by Using Microsoft Outlook, page 2-11

 • Rescheduling or Modifying a Meeting, page 2-13

 • Canceling a Meeting, page 2-15

Tips for Scheduling Secure Meetings
To maximize your meeting security, consider doing the following when you 
schedule:

 • Enter a password. 

This will require all participants to enter the password to join your meeting.

 • Restrict the meeting to profiled users only.

 • Do not list the meeting publicly.

 • Set the meeting entry and exit announcements to Beep + Name.

This ensures that you will hear the names of all participants when they enter 
and leave your meeting. If you hear a beep with no name, ask the new arrival 
to identify him- or herself immediately.
2-1
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Start a Meeting Right Away
 • When scheduling a series of recurring meetings, you can only schedule up to 
100 instances, even if you do not specify an end date or if you specify an end 
date later than 100 instances away.

How to Start a Meeting Right Away
There are two types of meetings that you can start right away. One is called a 
reservationless meeting. The other is a scheduled immediate meeting. Whether or 
not you can start a reservationless meeting is configured by your system 
administrator.

Note If your Cisco Unified MeetingPlace Express system is video-enabled, and your 
profile is set to allow video meetings, any meetings that you start right away will 
be scheduled with video-conferencing enabled.

 • Characteristics of a Reservationless Meeting, page 2-2

 • Starting a Reservationless Meeting from the Web, page 2-4

 • Starting a Reservationless Meeting from a Cisco Unified IP Phone, page 2-5

Characteristics of a Reservationless Meeting
A reservationless meeting is a meeting that is always reserved on the system for 
you. It is useful for when you want to have an impromptu meeting, but you have 
far less control over the meeting parameters than with a scheduled immediate 
meeting. The following settings and behavior are standard in a reservationless 
meeting.

 • Your meeting options are the default settings for your profile, as determined 
by your system administrator.

 • Your meeting ID is your phone profile number.

 • The subject of your meeting is set as your first and last name as they appear 
in your profile.

 • Anyone can attend a reservationless meeting.
2-2
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Start a Meeting Right Away
 • Anyone can see the details of a reservationless meeting on the Cisco Unified 
MeetingPlace Express web page.

 • Anyone can access the recording of a reservationless meeting.

 • Invitees do not receive a meeting notification.

 • Since you do not actively reserve meeting resources in advance of your 
meeting, there is the risk that resources may be unavailable at the time you 
want to start your meeting.

 • If your system administrator has set your profile so that all of your meetings 
must include a password, you must specify a password when you start each 
reservationless meeting. 

 • Participants who join a reservationless meeting before the scheduler will wait 
in a waiting room (where they cannot communicate with each other) until the 
scheduler arrives, unless one of the following is true:

 – The scheduler chooses to start the meeting when the first participant 
arrives.

 – Your system administrator enabled participants to initiate reservationless 
meetings that were started by another person, and one of the participants 
chose to do this. 

Note If you start the meeting, the cost of the meeting may be billed to your 
department. Contact your system administrator for information.

If you require functionality that is not available through reservationless meetings, 
schedule a meeting that starts immediately instead. 

Related Topics

 • How to Start a Meeting Right Away, page 2-2

 • Scheduling a Meeting, page 2-7
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Start a Meeting Right Away
Starting a Reservationless Meeting from the Web

Tip You can also start a reservationless meeting from the phone by pressing 1# then 
following the prompts that you hear.

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • Turn off any pop-up blockers.

 • Make sure that you are on the company network.

 • Make sure that you can see the Start Reservationless link on the Cisco Unified 
MeetingPlace Express web page.

If you cannot, you do not have permissions to start reservationless meetings. 
Schedule a meeting that starts immediately instead. See the “Scheduling a 
Meeting” section on page 2-7.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Click Start Reservationless.

Step 3 Do one of the following:

 • If your phone rings, answer it and follow any prompts that you hear. Skip all 
other phone-related steps in this procedure.

 • If your phone does not ring, check Call my phone/video endpoint # and 
enter the phone number where the system can reach you.

 • If you do not see the “Call my phone” option, proceed to Step 4.

Step 4 Check Enter web meeting room to join the web component of your meeting. 

If you want to join the voice or video component only, leave this unchecked.

Step 5 (Optional) Enter a password.

 • If you are going to join the meeting right away, enter a password in the Set 
Password field that appears above the Join Meeting button.
2-4
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Start a Meeting Right Away
 • If you are not going to join the meeting right away, enter a password in the 
Set Password field that appears above the Start Meeting Without Me button.

Note You must enter a password if your profile is configured to require it. You 
will not see this parameter if your profile does not require meeting 
passwords.

Step 6 Click Join Meeting or Start Meeting Without Me to start the meeting.

Step 7 (Optional) If you are not already in the voice meeting, dial the Cisco Unified 
MeetingPlace Express telephone number and follow the prompts to enter as a 
profiled user.

Step 8 Give invitees the following information so that they can join your meeting:

 • The URL and phone number of your Cisco Unified MeetingPlace Express 
system.

 • The meeting ID, which is your phone profile number.

 • The meeting password, if there is one.

Troubleshooting Tips

Reservationless meetings do not appear in the list of published meetings until the 
first person joins. This means that people who do not know your profile number 
will not be able to find your meeting until after the first participant joins.

Related Topics

 • Characteristics of a Reservationless Meeting, page 2-2

Starting a Reservationless Meeting from a Cisco Unified IP 
Phone

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • Make sure that you are allowed to start reservationless meetings.
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Schedule a Meeting
 • Select Cisco Unified MeetingPlace Express Phone View on your 
Cisco Unified IP Phone. See the “Accessing Cisco Unified 
MeetingPlace Express Phone View” section on page 14-4.

Procedure

Step 1 Select Start Reservationless on your Cisco Unified IP Phone.

Step 2 Wait while Cisco Unified MeetingPlace Express starts your meeting.

Step 3 Press the Join softkey.

Step 4 Answer the phone when it rings and follow the instructions that you hear.

Step 5 Give invitees the following information so that they can join your meeting:

 • The phone number of your Cisco Unified MeetingPlace Express system.

 • The meeting ID, which is the same as your phone profile number.

 • The meeting password, if there is one.

Related Topics

 • Characteristics of a Reservationless Meeting, page 2-2

How to Schedule a Meeting
By default, you can schedule both individual and recurring meetings up to two 
years in advance; your system administrator sets the exact limit for your system. 
Recurring meetings are meetings that take place at the same time over a period of 
time. You can schedule a meeting to recur daily, weekly, or monthly, set for 
specific days of the week or dates in a month.

Note You can schedule a meeting to start immediately, but you cannot schedule a 
meeting that starts more than 30 minutes in the past.

 • Scheduling a Meeting, page 2-7

 • Scheduling a Meeting on Behalf of Another User, page 2-10
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Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Schedule a Meeting
Scheduling a Meeting
A Cisco Unified MeetingPlace Express meeting typically includes a voice and 
web component. It may also include a video component if your Cisco Unified 
MeetingPlace Express system is configured to enable video conferencing. 

If your system is configured to allow participants who are not on your company 
network, you can also choose to either restrict or allow such participants in your 
meeting. 

Before You Begin

 • Consider your security needs. See the “Tips for Scheduling Secure Meetings” 
section on page 2-1.

 • Make sure that you are on the company network.

 • Know your Cisco Unified MeetingPlace Express username and password.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Click Schedule.

Step 3 Enter your meeting parameters keeping the following in mind:

Note Not all parameters are described below.

Option Action

Subject Enter the subject of your meeting. If 
you do not enter a subject, the system 
uses your last name. The subject can be 
up to 17 characters long.

Meeting ID Enter either numbers, letters, or a 
combination of both to identify your 
meeting. The meeting ID can be up to 
17 characters long. 
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Time Enter the time your meeting will start.

Tip To make this an immediate 
meeting, enter your current 
time as your start time.

Frequency Choose how many times you want to 
have your meeting.

If you choose Daily, Weekly, or 
Monthly, also choose your recurrence 
pattern.

Note Only system administrators 
can schedule continuous 
meetings.

Number of participants Enter the number of people you expect 
to attend your meeting. 

Tip If multiple users will be 
attending the meeting from one 
location, count them as one 
participant.

List meeting publicly

Note This parameter may not be 
available depending on your 
system configuration.

Check this checkbox if you want to 
make your meeting entry available for 
anyone who wants to see it.

Web meeting room access

Note This parameter may not be 
available depending on your 
system and profile 
configuration.

Choose how your participants will 
access your meeting.

 • Choose Company network only 
if all participants will be attending 
from behind the corporate firewall, 
that is, all participants are on the 
company network.

 • Choose Internet if you will have 
any participants attending from 
outside the corporate firewall, that 
is, they are not on the company 
network.

Option Action
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Step 4 Click Invitees; then, add participants.

Step 5 (Optional) Click More options; then, set additional options as needed.

Note Not all parameters are described below.

Step 6 Click Schedule.

Step 7 Review the details of the scheduled meeting and verify that they are correct.

Option Action

Language

Note This setting only affects the 
voice prompts and language of 
the web meeting room for the 
meeting that you are 
scheduling. 

Choose the language in which your 
meeting should take place. If you do 
not specify a language here, the 
meeting uses the language specified in 
your profile.

Entry announcement and Exit 
announcement

Choose how participants will be 
announced when they join and leave 
your meeting.

Web meeting room Choose how the web meeting room 
will be configured for your meeting.

 • Choose Full meeting room if you 
plan to share content during the 
meeting.

 • Choose Participant list only if 
you do not plan to share content 
during the meeting.

video type

Note This parameter may not be 
available depending on your 
system configuration.

Choose Default unless you are 
expecting to transmit video that 
requires more than the default 
maximum bit rate.
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If configured by the system administrator, the system will send meeting 
notifications to all invited participants.

Troubleshooting Tips

 • If you need to correct information on the Meeting Scheduled page, click 
Reschedule.

 • If the option that you need to change is not available, cancel this meeting by 
clicking Delete and schedule a new meeting.

 • If you tried to schedule a recurring meeting, but only a single meeting was 
scheduled, make sure that you specified a number of occurrences greater than 
one and an end date that is after today.

Related Topics

 • Logging In Through the Web, page 1-4

 • How to Invite Participants During the Scheduling Process, page 3-1

 • Canceling a Meeting, page 2-15

 • How to Resolve Schedule Meeting Problems, page 16-4

Scheduling a Meeting on Behalf of Another User
If you are a delegate of another user, you can schedule meetings on their behalf. 
All meetings scheduled by you on behalf of someone else are listed and billed 
according to the profile of that other user.

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • Know who you are a delegate for.

 • Make sure that you are on the company network.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Click Schedule.
2-10
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 2      Scheduling a Cisco Unified MeetingPlace Express Meeting
    How to Schedule a Meeting by Using Microsoft Outlook
Step 3 Locate the Schedule on Behalf dropdown box.

Step 4 Choose the user for whom you are scheduling.

Step 5 Enter your remaining meeting parameters.

Step 6 Click Invitees; then, add participants.

Step 7 (Optional) Click More options; then, set additional options as needed.

Step 8 Click Schedule.

Step 9 Review the details of the scheduled meeting and verify that they are correct.

If configured by the system administrator, the system will send meeting 
notifications to all invited participants.

Related Topics

 • Logging In Through the Web, page 1-4

 • How to Invite Participants During the Scheduling Process, page 3-1

 • Scheduling a Meeting, page 2-7

 • Canceling a Meeting, page 2-15

 • How to Resolve Schedule Meeting Problems, page 16-4

How to Schedule a Meeting by Using 
Microsoft Outlook

You must have the Cisco Unified MeetingPlace Express for Microsoft Outlook 
plug-in installed on your computer before you can schedule Cisco Unified 
MeetingPlace Express meetings from Microsoft Outlook. Your system 
administrator may have already installed the Microsoft Outlook plug-in for you.

This section describes how to check for and download the Microsoft Outlook 
plug-in. For information about how to use the Microsoft Outlook plug-in with 
Cisco Unified MeetingPlace Express, see the User Guide for Microsoft Outlook 
with Cisco Unified MeetingPlace Express Release 2.x.

 • Checking if the Microsoft Outlook Plug-in is Installed, page 2-12

 • Downloading the Microsoft Outlook Plug-in, page 2-12
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Checking if the Microsoft Outlook Plug-in is Installed

Before You Begin

If you are not familiar with how to create a meeting request in Microsoft Outlook, 
refer to your Microsoft Outlook help documentation.

Procedure

Step 1 Open Microsoft Outlook and create a meeting request.

Step 2 Confirm whether you see a MeetingPlace tab.

 • If you see a MeetingPlace tab, click it and fill in the parameters to schedule 
the MeetingPlace component of your meeting.

 • If you do not see the MeetingPlace tab, your system is not configured to 
schedule Cisco Unified MeetingPlace Express meetings from Microsoft 
Outlook.

Related Topics

 • Downloading the Microsoft Outlook Plug-in, page 2-12

 • You can find complete information for using the Microsoft Outlook plug-in 
with Cisco Unified MeetingPlace Express in the User Guide for Microsoft 
Outlook with Cisco Unified MeetingPlace Express Release 2.x.

Downloading the Microsoft Outlook Plug-in

Before You Begin

Close all Microsoft Outlook and Microsoft Office applications.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Go to the Attend or Schedule Meeting web page.

Step 3 Click Download Outlook plugin.
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The File Download—Security Warning dialog box appears.

Step 4 Click Save.

Step 5 Navigate to your desktop and click Save.

Step 6 Go to your desktop and double-click the file called setup.exe.

The Cisco MeetingPlace for Outlook dialog box appears.

Step 7 Click OK to start the installation.

Step 8 Click OK when the installation is complete.

Step 9 Restart Microsoft Outlook.

Troubleshooting Tips

If you are unable to download the Microsoft Outlook plug-in, contact your system 
administrator.

Rescheduling or Modifying a Meeting
You can modify any scheduled meeting, including the following recurring 
meetings:

 • All meetings in the series, if no meetings in the series have occurred.

 • Individual instances that have not yet occurred.

 • All meetings in the series that have not yet occurred.

 • All meetings in the series starting with any instance that has not yet occurred.

Note If you schedule a meeting by using Microsoft Outlook and then modify or delete 
the meeting using an interface other than Microsoft Outlook, the system will not 
send out an updated notification to your invitees.

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • You must be the owner or scheduler of the meeting that you want to modify, 
or you must be an attendant.
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 • You can change meeting details except for the meeting ID and frequency of 
the meeting. If you need to change the meeting ID or frequency, cancel this 
meeting and schedule a new one.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express. 

Step 2 Find the meeting that you want to change.

Note If you are modifying a recurring meeting, make sure that the date range 
you enter in your find criteria includes the first date of the series (or part 
of the series) that you want to change.

Step 3 Click the meeting ID of the meeting that you want to change.

Note If the meeting is a recurring meeting, multiple instances of the meeting 
may appear in the list of found meetings. Make sure that you click the first 
instance of the series or subseries that you want to modify.

The Meeting Details page of the meeting you selected appears.

Step 4 Click Reschedule.

Step 5 If you are changing a recurring meeting, choose one of the following; then, click 
OK:

 • Change this occurrence only

 • Change this and all future occurrences

Step 6 Enter new values as needed.

Step 7 Click Schedule.

Step 8 Verify that the meeting details are as you intended and reschedule again if 
necessary.
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Troubleshooting Tips

The system automatically sends updated meeting invitations if any of the 
following changes:

 • Start time

 • Meeting ID

 • Password

 • List of invitees

No other changes generate a notification.

Related Topics

 • Logging In Through the Web, page 1-4

 • Finding a Meeting or Recording, page 4-1

 • Canceling a Meeting, page 2-15

Canceling a Meeting
You can cancel any scheduled meeting that has not yet started. If the meeting is 
recurring, you can cancel the following:

 • The entire series, if no meetings in the series have occurred.

 • Individual instances that have not yet occurred.

 • All meetings in the series that have not yet occurred.

 • All meetings in the series starting with any instance that has not yet occurred.

Before You Begin

 • Know your Cisco Unified MeetingPlace Express username and password.

 • Make sure that you are the owner or scheduler of the meeting you want to 
cancel, or an attendant.

 • Make sure that you are on the company network.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.
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Step 2 Find the meeting that you want to cancel.

Note If you need to delete multiple instances of a recurring meeting and some 
instances in the series have passed already, find the meeting from which 
date you want to cancel all future meetings. This date can be the first 
meeting in the series that has not yet occurred, or it can be any instance 
in the future.

Step 3 Click the meeting ID of the meeting that you want to cancel.

Note If the meeting is a recurring meeting, multiple instances may be included 
in the list of found meetings. Make sure that you click the first instance 
of the series or subseries that you want to delete.

The Meeting Details page of the meeting you selected appears.

Step 4 Click Delete.

Step 5 If you are deleting a recurring meeting, choose one of the following; then, click 
OK:

 • Delete this occurrence only

 • Delete this and all future occurrences

Step 6 Click OK.

Related Topics

 • Logging In Through the Web, page 1-4

 • Finding a Meeting or Recording, page 4-1
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Inviting Participants to a Cisco Unified 
MeetingPlace Express Meeting

You can invite participants during the scheduling process or during a meeting. 
This section describes how to invite participants so that they receive e-mailed 
notifications with the meeting details.

 • How to Invite Participants During the Scheduling Process, page 3-1

 • How to Invite Participants During a Meeting, page 3-3

How to Invite Participants During the Scheduling 
Process

There are several ways for you to invite participants while scheduling a meeting. 
This section describes the most common methods.

 • Inviting Participants by Using the Directory, page 3-1

 • Inviting Attendees by Entering E-Mail Addresses, page 3-3

Inviting Participants by Using the Directory
The Cisco Unified MeetingPlace Express directory stores information about all 
profiled users in your organization. Inviting profiled users by using the directory 
offers the following advantages:
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 • Participants who have joined the voice meeting can have the system call 
profiled invitees who have not yet joined to bring them into the meeting.

 • Profiled invitees can join the meeting automatically by using the Find Me 
feature, which is described in the “Specifying Your Preferred Method of 
Joining Meetings” section on page 15-4.

Before You Begin

Fill in your meeting parameters on the Schedule Meeting page.

Procedure

Step 1 Click Invitees.

Step 2 Locate the From Directory field.

Step 3 Enter the name of a person or a Cisco Unified MeetingPlace Express username; 
then, click .

Any users in the directory whose name or username matches the criteria you 
entered will appear in the box below the From Directory field.

Step 4 Click the name of the person you want to invite from the resulting list. 

Tip Shift-click or control-click the names to select multiple names. Mac 
users: use command-click when the instructions call for control-click.

Step 5 Click the right arrow button to move the selected name to the Invitees list.

Tip Click the e-mail address and click Remove to remove a name from the 
Invitees list.

Step 6 Repeat Step 3 to Step 5 to add more invitees.

What to Do Next

Continue scheduling your meeting. See the “Scheduling a Meeting” section on 
page 2-7 for instructions.
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The scheduling process continues on the same page that you have been working 
with.

Inviting Attendees by Entering E-Mail Addresses 

Before You Begin

Fill in your meeting parameters on the Schedule Meeting page.

Procedure 

Step 1 Click Invitees.

Step 2 Enter a complete e-mail address for By Email.

Step 3 Click the arrow to the right of By Email.

Tip Click the e-mail address and click Remove to remove a name from the 
Invitees list.

Step 4 Repeat Steps Step 2 to Step 3 to add more invitees.

What to Do Next

Continue scheduling your meeting. See the “Scheduling a Meeting” section on 
page 2-7 for instructions. The scheduling process continues on the same page that 
you have been working with.

How to Invite Participants During a Meeting
After sending the initial meeting invitation, there are several ways for you to add 
more participants to your meeting.

 • Prerequisites for Inviting Participants During a Meeting, page 3-4

 • Inviting Participants by E-Mail from Inside the Web Meeting Room, page 3-4
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 • Dialing Out to a Participant Who is Already in the Web Meeting Room, 
page 3-5

 • Dialing Out to a Participant Who is Not in the Web Meeting Room, page 3-6

 • Creating a List of Participants to Dial Later, page 3-7

 • Dialing Out to Several Participants Simultaneously, page 3-8

Prerequisites for Inviting Participants During a Meeting
Make sure you satisfy the following before attempting to invite participants 
during a meeting:

 • You must be a moderator.

 • You must be able to dial out.

 • You must already be in the web meeting room.

Inviting Participants by E-Mail from Inside the Web Meeting 
Room

Use this method to easily invite a new participant. All of the information that the 
invitee needs to attend is automatically included in the e-mail. You can add more 
information, such as an agenda, if you wish.

Before You Begin

Read the “Prerequisites for Inviting Participants During a Meeting” section on 
page 3-4. 

Procedure

Step 1 Click Meeting > Invite Participants.

Step 2 Click Compose e-mail.

A new e-mail message opens with prepopulated information.

Step 3 Enter addressee information and modify the Subject field, if desired.

Step 4 Send your e-mail.
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Step 5 Click Done to close the Invite window and return to the meeting.

Dialing Out to a Participant Who is Already in the Web Meeting 
Room

If a participant has joined the web meeting room but not the voice meeting, you 
can tell Cisco Unified MeetingPlace Express to call the participant and bring the 
participant into the voice or video meeting.

Before You Begin

Read the “Prerequisites for Inviting Participants During a Meeting” section on 
page 3-4. 

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click the name of the participant that you want to add to the voice meeting.

Step 3 Click  > Call Selected User.

Note If this is a video-enabled meeting and the phone number you enter is 
connected to a video endpoint, the person will enter the meeting via 
video.

Step 4 Either enter a new phone number or select one from the list of numbers associated 
with the participant, if available.

 • Enter the phone number the way you would dial it from your desk phone. For 
example, a 5-digit extension for an internal phone or a full 12-digit number 
including 9, 1, and area code for an outside call. 

Step 5 Click Call.
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Related Topics

For a quick list of commands you can initiate by telephone during a meeting, see 
the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html.

Dialing Out to a Participant Who is Not in the Web Meeting Room 
From inside the web meeting room of a meeting in progress, you can tell 
Cisco Unified MeetingPlace Express to dial out to someone who is not in the 
meeting and bring that person into the voice or video meeting.

Before You Begin

Read the “Prerequisites for Inviting Participants During a Meeting” section on 
page 3-4. 

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click  > Call New User.

Step 3 Enter the name and phone number of the person.

 • Enter the phone number the way you would dial it from your desk phone. For 
example, a 5-digit extension for an internal phone or a full 12-digit number 
including 9, 1, and area code for an outside call. 

 • If this is a video-enabled meeting and the phone number you enter is 
connected to a video endpoint, the person will enter the meeting through 
video.

Step 4 Click Call Now to call the person immediately.

Related Topics

For a quick list of commands you can initiate by telephone during a meeting, see 
the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html.
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Creating a List of Participants to Dial Later
From inside the web meeting room of a meeting in progress, you can create a list 
of people to bring into the voice or video meeting. After you do this, you can tell 
the system at any time during the meeting to call those people.

Before You Begin

Read the “Prerequisites for Inviting Participants During a Meeting” section on 
page 3-4. 

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click  > Call New User.

Step 3 Enter the name and phone number of the person.

Note If this is a video-enabled meeting and the phone number you enter is 
connected to a video endpoint, the person will enter the meeting through 
video.

Step 4 Click Call Later.

The person is added to the participant list as an offline participant.

Related Topics

 • Removing Participants from the Web Meeting Room, page 7-6

What to Do Next

When you have added all of the people you want Cisco Unified 
MeetingPlace Express to call, follow the procedure in the “Dialing Out to Several 
Participants Simultaneously” section on page 3-8.
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Dialing Out to Several Participants Simultaneously
From inside the web meeting room of a meeting in progress, you can tell 
Cisco Unified MeetingPlace Express to simultaneously call several people and 
bring them into the voice or video meeting.

Before You Begin

 • Read the “Prerequisites for Inviting Participants During a Meeting” section 
on page 3-4. 

 • Create a list of participants to call. See the “Creating a List of Participants to 
Dial Later” section on page 3-7.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Control-click the names of the participants that you want to add to the voice 
meeting.

Tip Mac users: use command-click when the instructions call for 
control-click.

Step 3 Click  > Call Selected User or Call New User depending on which option 
you see.
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Finding a Cisco Unified MeetingPlace 
Express Meeting

 • Finding a Meeting or Recording, page 4-1

 • Finding Cisco Unified Personal Communicator Meetings, page 4-3

Finding a Meeting or Recording
You can find meeting details or recordings for past, present, and future meetings. 
The list of found meetings depends on the options you choose.

Note Your system administrator may purge records of older meetings at any time. You 
cannot find purged meetings.

Before You Begin

 • Know the URL of the Cisco Unified MeetingPlace Express server on which 
the meeting is scheduled.

 • Make sure that you are on the company network.

Procedure

Step 1 Open a web browser and enter the URL of the Cisco Unified 
MeetingPlace Express server.
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Step 2 (Optional) Log in as a profiled user.

Step 3 Click Find on the top of the page.

Step 4 Choose your search criteria:

Step 5 Enter a date range. 

If you do not enter a date range, the search returns meetings that occur today with 
your search criteria.

Step 6 Click Find.

Step 7 Scroll through the list to find your meeting. 

 • If additional meetings meet your criteria, a list of page numbers appear at the 
bottom of the list of meetings. 

 • Click the arrows or a page number to view additional meetings.

Tip Continuous meetings are always at the end of the entire list.

Step 8 Click a meeting ID to see the meeting details.

Troubleshooting Tips

If you do not see the meeting you are looking for:

To Do This

Find meetings that you scheduled and 
to which you were invited.

Note You must have logged in with 
your profile to see this option.

Click My meetings.

Find meetings that are available for 
anyone to see. 

Click Public meetings.

Find meetings that have recordings. Check Public recordings.

Find meetings that have a particular 
meeting ID.

Enter the Meeting ID.
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 • Make sure that you entered your search criteria correctly.

 • The meeting may not be a published meeting.

 • The meeting you are looking for may have been purged.

 • The meeting may be a Cisco Unified Personal Communicator meeting.

Related Topics

 • How to Resolve Find Meeting Problems, page 16-7

Finding Cisco Unified Personal Communicator 
Meetings

When a Cisco Unified Personal Communicator user starts a web meeting, the 
Cisco Unified MeetingPlace Express system generates a meeting URL and sends 
it to the meeting initiator.

You must know the meeting URL to find a Cisco Unified Personal Communicator 
meeting. Contact the meeting initiator for this information. Such meetings are not 
listed on the Cisco Unified MeetingPlace Express Attend page.
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Joining a Cisco Unified 
MeetingPlace Express Meeting

A Cisco Unified MeetingPlace Express meeting typically, but not always, 
consists of a voice component and a web component. It may also contain a video 
component. You can join the separate meeting components individually or all at 
once.

 • Tips for Joining a Meeting, page 5-1

 • Best Practices When Joining a Video Meeting, page 5-2

 • How to Join a Meeting, page 5-3

 • Requesting Entry to a Locked Meeting, page 5-11

 • How to Join a Meeting from Your Cisco Unified IP Phone, page 5-12

Tips for Joining a Meeting
 • Call your Cisco Unified MeetingPlace Express system at least once before 

joining any meetings and record your name. See the “Recording Your Profile 
Name” section on page 15-6.

The system will prompt you for your name each time it dials out to you to join 
a meeting until you call in and record a name for your profile.

 • Aim to join your meeting shortly before or at its official start time. 
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Your system administrator determines exactly how much in advance you can 
join your meeting. The default is 10 minutes. If no one joins within 30 
minutes, the system automatically ends the meeting.

 • Turn off any pop-up blockers that you may have installed on your system.

 • Be aware of time zones.

The meeting start time that appears on the invitation may not be in your time 
zone. If the meeting scheduler is located in a different time zone, you may 
need to adjust the start time to your time zone.

 • Follow the instructions in your meeting notifications.

The information that appears on your meeting notifications may differ from 
the descriptions in this documentation, depending on customizations made by 
your system administrator.

Best Practices When Joining a Video Meeting
To ensure the best possible experience in a video meeting, follow the suggested 
best practices:

 • Make sure that your video endpoint is configured before joining your 
meeting. 

Endpoints must support at least the minimum bit rate as specified in the video 
type, or they will not send or receive video. Video meetings support a mix of 
video endpoints and audio-only endpoints in the same conference.

If your Cisco Unified MeetingPlace Express system is video-enabled, it will 
recognize when you are joining a meeting through video and place you in the 
video component of your meeting. If there is no video component to either 
the meeting or your method of joining, the system will automatically place 
you in the meeting as an audio-only participant.

 • If you are only listening (and not speaking), then mute your phone during the 
meeting.

 • Do not use a speakerphone, which may generate echoes, ringing sounds, or 
audio feedback.

 • If you use a microphone that is built into your video endpoint, then keep the 
endpoint away from fans, vents, and other sources of noise.
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 • For softphones, such as Cisco Unified Personal Communicator with a Cisco 
VT Camera or Cisco IP Communicator with Cisco Unified Video Advantage:

 – Do not use the microphone that is built into your computer. These 
microphones tend to pick up a lot of background noise.

 – We highly recommend that you use a quality headset that is equipped 
with a microphone. 

 – Whenever multiple microphones are available, make sure that your 
computer and video endpoint are configured to use the desired 
microphone. For example, if you are using Cisco Unified Personal 
Communicator with a Cisco VT Camera and you have a headset that is 
equipped with a microphone, make sure that your system is configured to 
use the headset microphone.

 • See the documentation for your specific endpoint product to optimize audio 
settings and resolve audio problems.

How to Join a Meeting
There are several ways for you to join a Cisco Unified MeetingPlace Express 
meeting. This section describes the most common methods.

 • Preparing to Join a Meeting for the First Time, page 5-3

 • Joining a Meeting Through an E-Mailed Invitation, page 5-4

 • Joining a Meeting Through Your Web Browser, page 5-6

 • Joining a Voice or Video Meeting by Dialing In, page 5-9

 • Joining a Voice or Video Meeting from Inside the Web Meeting Room, 
page 5-10

Preparing to Join a Meeting for the First Time
Before you join your first meeting, complete the browser test to ensure that your 
computer is ready to join the web meeting room. The browser test verifies that 
your computer has the required software, checks your network connection, and 
determines whether you have pop-up blocker software enabled.
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The browser test also determines whether or not you have the Cisco Unified 
MeetingPlace Express Add-in installed, which you will need if you plan to share 
content on your computer with meeting participants. For more information about 
this screen sharing feature, see the “How to Share a Desktop, Window, or 
Application” section on page 9-1

Procedure

Step 1 Open a web browser and enter the URL of your Cisco Unified 
MeetingPlace Express server

Step 2 Click Browser Test.

Step 3 Wait a few moments while the browser test runs.

Step 4 Follow the browser test instructions. 

 • If the application prompts you to download the correct version of the Adobe 
Flash Player, follow the instructions that you see.

 • If you see a Troubleshooting link, click it and follow instructions.

 • If you see a Download the Add-in button, click it then follow the steps in the 
install wizard.

Note You must download the Add-in if you plan to share content from your 
computer or see any notifications while viewing shared content full 
screen. You must install the Adobe Flash Player before you can install the 
Add-in.

Joining a Meeting Through an E-Mailed Invitation

Before You Begin

 • Complete the “Preparing to Join a Meeting for the First Time” section on 
page 5-3.

 • Open your e-mailed meeting invitation.
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 • If you plan to join the video component of your meeting, read the “Best 
Practices When Joining a Video Meeting” section on page 5-2.

Procedure

Step 1 Open your e-mailed invitation.

Step 2 Click the Meeting URL link.

 • If this meeting was scheduled to allow participants from both inside and 
outside the corporate firewall, choose the appropriate link based on your 
location.

 • If you see any security alerts, click Yes to proceed.

 • Cisco Unified MeetingPlace Express appears with the Meeting Details page 
open.

Step 3 Check Call my phone/video endpoint # and enter the phone number where you 
can be reached.

 • Enter your phone number the way you would dial it from your desk phone. 
For example, a 5-digit extension for an internal phone or a full 12-digit 
number including 9, 1, and area code for an outside call. 

 • If you do not see this option, proceed to Step 4.

Step 4 Check Enter web meeting room.

Step 5 Click Join Meeting.

Note If you do not see any options, it is either too early to join this meeting or 
this meeting has ended. 

Step 6 Log in.

 • Enter your username and password if you have one.

 • Enter your name in the Join as Guest field if you do not have a username and 
password.

Step 7 Click Join Meeting.
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Troubleshooting Tips

 • If you did not receive an e-mailed invitation as expected, make sure that you 
have entered an e-mail address in your profile. See the “Changing Your 
Personal Profile Settings” section on page 15-2.

 • If you see a “Meeting not found” message, it is either too early to join this 
meeting, or this meeting has ended. Either wait to join the meeting or make 
sure that you have the correct meeting information.

Related Topics

 • How to Resolve Join Meeting Problems, page 16-10

 • How to Resolve Problems Joining the Web Meeting Room, page 16-12

Joining a Meeting Through Your Web Browser
To simplify the attend process, you may be able to have the system call you. This 
is a convenient way to join all of the components of your meeting at the same time.

Before You Begin

 • Know your username and password (if required).

 • Know the meeting ID (if required).

 • If this is the first time you are joining a meeting, complete the “Preparing to 
Join a Meeting for the First Time” section on page 5-3.

 • If you plan to join the video component of your meeting, read the “Best 
Practices When Joining a Video Meeting” section on page 5-2.

Procedure

Step 1 Open a browser and enter the URL of your Cisco Unified MeetingPlace Express 
server.

Step 2 Click Attend if you are not already on the Attend page.

Step 3 Enter the meeting ID of the meeting that you want to attend and click Go.

 • If you do not know the meeting ID and you are on the company network, 
scroll through the list of active meetings to find your meeting then click the 
meeting ID.
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 • If you do not know the meeting ID and you are not on the company network, 
contact the meeting scheduler for the meeting ID.

Step 4 If you see a Restricted access page, enter the information required, then click OK:

Step 5 Check Call my phone/video endpoint # and enter the phone number where you 
can be reached.

 • Enter your phone number the way you would dial it from your desk phone. 
For example, a 5-digit extension for an internal phone or a full 12-digit 
number including 9, 1, and area code for an outside call. 

 • If you do not see this option, proceed to Step 6.

Step 6 Check Enter web meeting room.

Step 7 Click Join Meeting.

Note If you do not see any options, it is either too early to join this meeting, or 
this meeting has ended. 

Step 8 Log in.

 • Enter your username and password.

 • Enter your name in the Join as Guest field if you do not have a username and 
password.

Step 9 Join your meeting.

To Do This

Join a standard meeting. Click Join Meeting. 
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Step 10 (Optional) If you are not in the voice meeting, dial in by using the telephone 
number displayed in the web meeting room.

Troubleshooting Tips

 • The Meeting Details page remains open on your computer after you join the 
meeting.

 • If you know a meeting will start at a certain time but you do not see it on the 
Find Meetings page, do not click the Refresh button in your browser. 
Refreshing your browser effectively takes you back to the previous screen. 
Instead, click on another tab, such as Find or Schedule and then click Attend 
again.

 • Remember to call your Cisco Unified MeetingPlace Express system at least 
once before joining any meetings and record your name. If you do not store a 
recorded name in your profile, the system will prompt you for your name each 
time it dials out to you.

Related Topics

 • How to Resolve Join Meeting Problems, page 16-10

 • How to Resolve Problems Joining the Web Meeting Room, page 16-12

 • Recording Your Profile Name, page 15-6

Start a reservationless meeting without 
joining.

Click Start Meeting Without Me.

Note You see this option only if you 
are the owner of the meeting.

Join a reservationless meeting that has 
not yet started.

Click Join the waiting room.

Note You see this option only if you 
are attending a reservationless 
meeting and are not the 
meeting owner. If you prefer 
not to tie up your telephone 
line while you wait, join by 
telephone after you know that 
the meeting has started.

To Do This
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Joining a Voice or Video Meeting by Dialing In

Note If your profile is configured to automatically connect you to your meeting, that is, 
“auto attend” the system will connect you as soon as you call the server. If you 
have multiple meetings scheduled, it will automatically log you in to the system 
so that you can choose which meeting to join.

Before You Begin

 • Know the phone number of your Cisco Unified MeetingPlace Express server.

 • Know the meeting ID.

 • Know your phone profile number and password (if required).

 • If you plan to join the video component of your meeting, read the “Best 
Practices When Joining a Video Meeting” section on page 5-2.

Procedure

Step 1 Dial the telephone number of your Cisco Unified MeetingPlace Express server.

Step 2 Follow the prompts that you hear.

Related Topics

 • How to Resolve Join Meeting Problems, page 16-10

 • For a quick list of commands you can initiate by telephone during a meeting, 
see the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.htm
l.
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Joining a Voice or Video Meeting from Inside the Web Meeting 
Room

Depending on settings that the Cisco Unified MeetingPlace Express system 
administrator makes, you may be able to have the system call you when you want 
to join the voice or video component of your meeting. The participant list more 
accurately reflects your status if the system calls you than if you dial in.

Before You Begin

 • Make sure that you are in the web meeting room.

 • Make sure that you have outdial privileges. Your system administrator 
determines who has access to this feature.

 • If you plan to join the video component of your meeting, read the “Best 
Practices When Joining a Video Meeting” section on page 5-2.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click My Status > Call My Phone/Video Endpoint.

Step 3 Enter your name and phone number where the system can reach you.

 • Enter your phone number the way you would dial it from your desk phone. 
For example, a 5-digit extension for an internal phone or a full 12-digit 
number including 9, 1, and area code for an outside call. 

Step 4 Click Call.

Step 5 Answer your phone when it rings and follow the prompts that you hear.

Troubleshooting Tips

If you cannot join the voice component of your meeting by having the system call 
you, call in by dialing the Cisco Unified MeetingPlace Express telephone number 
manually then following the prompts.

Related Topics

 • How to Resolve Voice Meeting Problems, page 16-19
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 • How to Resolve Video Meeting Problems, page 16-20

 • For a quick list of commands you can initiate by telephone during a meeting, 
see the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.htm
l.

Requesting Entry to a Locked Meeting
Meeting moderators can lock meetings to prevent or restrict additional 
participants from joining. However, you may be able to request entry to a locked 
meeting.

 • If you try to attend a meeting via the web and you see a Request Entry button, 
the moderator has locked the meeting but you can request entry.

 • If you try to attend a meeting and you see a notice that the meeting is locked 
and there is no Request Entry button, the moderator has chosen not to allow 
any new arrivals into the meeting at this time. You can try again to attend if 
the moderator unlocks the meeting later.

This section describes how to request entry to a locked meeting through the web.

Tip You may also hear that a meeting is locked when attempting to join through the 
phone. In this circumstance, follow the prompts that you hear to request entry to 
the locked meeting.

Before You Begin

In the page that appears when you try to join the web meeting room, look for a 
Request Entry button.

 • If it is there, continue with this procedure.

 • If it is not there and you want to join the voice meeting, dial in to the meeting 
by using the Cisco Unified MeetingPlace Express telephone number and 
follow the prompts that you hear. 

Procedure

Step 1 Click Request Entry.
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Do not close the window that appears.

Step 2 Wait for the moderator to respond to your request. 

Troubleshooting Tips

 • The moderator may not respond immediately. Wait until you are either 
automatically entered into the meeting or you see a note stating that your 
request has been denied.

 • If the presenter appears to be taking a long time to respond, it is possible that 
the presenter is unable to interrupt the presentation just now or does not see 
your entry request. Try contacting the presenter or another meeting 
participant via another method.

How to Join a Meeting from Your Cisco Unified IP 
Phone

This section describes the various ways that you can join a meeting by using 
Cisco Unified MeetingPlace Express Phone View on your Cisco Unified IP 
Phone.

 • Joining a Meeting from Your Cisco Unified IP Phone, page 5-12

 • Joining a Meeting from Your Cisco Unified IP Phone When You Do Not 
Know the Meeting ID, page 5-13

 • Joining a Continuous Meeting from Your Cisco Unified IP Phone, page 5-14

Joining a Meeting from Your Cisco Unified IP Phone

Before You Begin

 • Know your username and password.

 • Know the meeting ID.

 • Know the meeting password (if required).

 • Complete the “Accessing Cisco Unified MeetingPlace Express Phone View” 
section on page 14-4.
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Procedure

Step 1 Press 1.

Step 2 Enter the meeting ID.

Step 3 Press the Submit softkey.

Step 4 Select the meeting to join. 

Meetings in progress are indicated by the @ symbol.

Step 5 Press the Join softkey.

Step 6 If prompted for a meeting password, enter it, then press Submit.

Note If you are joining a password-protected meeting from your Cisco Unified 
IP Phone, you will be prompted to enter the meeting password twice.

Step 7 When the phone rings, answer it and follow the prompts that you hear.

Troubleshooting Tips

If the phone does not ring to join you to your meeting, it is possible that you do 
not have permissions to call out of meetings. See your system administrator.

Joining a Meeting from Your Cisco Unified IP Phone When You 
Do Not Know the Meeting ID 

In the following circumstances, you can join a meeting even when you do not 
know the meeting ID:

 • The meeting is a published meeting.

 • You either scheduled it or you are invited to it.

Before You Begin

 • Know your username and password.

 • Know the meeting password (if required).
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 • Make sure that you can call out of meetings.

 • Complete the “Viewing Lists of Meetings On Your Cisco Unified IP Phone” 
section on page 14-5 to first find your meeting.

Procedure

Step 1 Select the meeting to join. 

Meetings in progress are indicated by the @ symbol.

Step 2 Press the Join softkey. 

Step 3 If prompted for a meeting password, enter it, then press Submit.

Note If you are joining a password-protected meeting from your Cisco Unified 
IP Phone, you will be prompted to enter the meeting password twice.

Step 4 Follow the prompts that you hear.

Troubleshooting Tips

If you do not see a Join softkey, the following may be true:

 • It is too soon to attend the meeting.

 • The meeting is over.

 • You have already joined the meeting.

 • You are not permitted to join it.

Joining a Continuous Meeting from Your Cisco Unified IP Phone
A continuous meeting is a permanent meeting that is always in session, even after 
everyone leaves and hangs up. You can join a continuous meeting at any time.

Before You Begin

 • Know your username and password.

 • Know the meeting password (if required).
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 • Make sure that you can call out of meetings.

 • Complete the “Viewing Meeting Details On Your Cisco Unified IP Phone” 
section on page 14-6.

Procedure

Step 1 Select the meeting to join. 

Meetings in progress are indicated by the @ symbol.

Step 2 Press the Join softkey.

Step 3 If prompted for a meeting password, enter it, then press Submit. 

Note If you are joining a password-protected meeting from your Cisco Unified 
IP Phone, you will be prompted to enter the meeting password twice.

Step 4 Follow the prompts that you hear.
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Controlling Your Personal 
Cisco Unified MeetingPlace Express 
Meeting Experience

 • Muting Your Voice, page 6-1

 • Turning Off Your Video Display, page 6-2

 • Displaying the Web Meeting Room as Full Screen, page 6-3

 • Displaying Shared Content on the Entire Screen, page 6-4

 • Enlarging Shared Content to Make it Easier to See, page 6-5

 • Disabling Pop-up Chat Notifications, page 6-6

 • Changing Your Meeting Language from the Web, page 6-7

 • Leaving the Web Meeting Room, page 6-8

Muting Your Voice
From inside the web meeting room, you can mute your audio transmission so that 
others cannot hear you or any background noise in your environment. If you are 
attending your meeting through a video endpoint, this procedure will mute the 
audio on your video endpoint.

Before You Begin

You must be in the web meeting room. 
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Note Participants in a share-only meeting can mute and unmute themselves from inside 
the voice or video component of their Cisco Unified Personal Communicator 
meeting.

Procedure

If you are muted, the muted icon appears next to your name.

Tip Do not mute yourself by using the Mute button on your phone, if your phone has 
one. If you use the mute button on your phone and then put the meeting on hold, 
“on-hold” music may play into the meeting room.

Turning Off Your Video Display
Cisco Unified MeetingPlace Express displays one video window at a time. The 
video stream of the active speaker is sent to all endpoints in the conference, and 
the video stream of the previous speaker is sent to the current active speaker. 
When only one endpoint is in the conference, the video stream of the caller is 
reflected. 

The following table describes some of the things you can do to control your video 
display.

To Do This

Mute yourself from inside the web 
meeting room.

Click My Status > Mute Me in the 
participant list.

Unmute yourself from inside the web 
meeting room.

Click My Status > Un-Mute Me in the 
participant list.

Mute or unmute yourself by using your 
telephone.

Press #5 on your telephone keypad.
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Troubleshooting Tips

Cisco Unified MeetingPlace Express is configured to display the video of the last 
active video speaker. If the next speaker in the meeting is a participant who is not 
connected to a video endpoint, that is, an audio-only participant, the video 
transmission will still display that of the last active video speaker. 

Related Topics

 • How to Resolve Video Meeting Problems, page 16-20

Displaying the Web Meeting Room as Full Screen
By default, the web meeting room is displayed in a standard browser window 
along with the display of all of your operating system elements, such as the Start 
menu, the Close Window button in the title bar of the web meeting room window, 
and all other applications. 

However, you can choose to view the web meeting room in full screen mode, 
which will hide everything on your computer except the web meeting room.

Note This topic describes how to display your web meeting room as full screen, not 
content that is being shared during a meeting as full screen. For information about 
the shared content feature, see the “Displaying Shared Content on the Entire 
Screen” section on page 6-4.

To Do This

Switch off your video display. Use the Hold feature on your phone.

Restore your video display. Use the Resume feature on your phone.

Ensure that your video display is not 
active.

Press #5 on your phone to mute your 
audio. 

Since video is determined by the last 
active speaker, muting your audio 
should turn off your video display.
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Before You Begin

You must be in the web meeting room.

Procedure

Step 1 Locate the menu bar.

Step 2 Choose Meeting > Full screen to toggle between full screen view and standard 
view.

Troubleshooting Tips

 • If you are attending a meeting that includes the full meeting room, all of the 
different areas of your web meeting room (participant list, notes, chat, and 
shared content) remain visible even when you are in full screen mode.

 • If you are using the Windows operating system and operating system 
elements are hidden from view, press Alt-Tab to cycle through other 
applications that are open on your computer.

Displaying Shared Content on the Entire Screen
To make shared content easier to see, enlarge it so that it fills your entire screen. 
Enlarging the shared content will hide the following elements:

 • All elements of the operating system including the title bar of the web 
meeting room window and the Close Window button.

Tip The appearance of your full-screen view depends on whether or not you 
have installed the Cisco Unified MeetingPlace Express Add-in. If you 
have not installed the Add-in, browser elements such as the title bar 
remain visible.

 • All other applications.

 • The participant list, chat, and notes functions if you are in the full web 
meeting room. 
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Tip If you installed the Add-in, choose to see a pop-up notifier for your chat 
messages.

Before You Begin

If you are a moderator or presenter, do the following:

1. Locate the Share pod.

2. Click the arrow next to the Full screen button.

3. If there is a check mark beside “Presenter’s changes affect everybody” click 
it to remove the check mark.

Note A moderator or presenter may have made the Full Screen feature unavailable to 
participants with audience permissions.

Procedure

Step 1 Locate the Share pod.

Step 2 Click Full screen.

Step 3 Click Full screen again to cancel full screen viewing.

Related Topics

 • Displaying the Web Meeting Room as Full Screen, page 6-3

 • How to Control How Others View Shared Content, page 9-11

Enlarging Shared Content to Make it Easier to See
Procedure

Step 1 Locate the Share pod.

Step 2 Do one of the following:
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Disabling Pop-up Chat Notifications
If you do not want chat notifications to appear while you are presenting, disable 
them by following this procedure. 

By default, chat notifications are enabled.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.

 • Install the Cisco Unified MeetingPlace Express Add-in. See the “Preparing to 
Share Content” section on page 9-2.

Procedure

Step 1 Locate the Chat pod.

Step 2 Click  > Disable Chat Notifications.

Troubleshooting Tips

Choose Disable Chat Notifications again to enable chat notifications.

To Do This

View the entire screen scaled to fill the 
Share pod.

Click .

See a scrollable, full-resolution view 
of the shared screen.

Click .
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Changing Your Meeting Language from the Web
You can change the language of your Cisco Unified MeetingPlace Express 
experience each time you use the application. The language that you choose 
affects the following: 

 • Voice prompts 

 • Application web pages for meetings that you schedule

 • Cisco Unified MeetingPlace Express Phone View on your Cisco Unified IP 
Phone 

Your language selection does not affect meetings that you did not schedule. When 
you attend a meeting that you did not schedule, the web meeting room always 
displays the language that is specified in the profile of the meeting scheduler.

Note If your organization has not purchased any language licenses, only the system 
default language is used.

Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Click the language of your choice from the bottom of any page, except the web 
meeting room.

Related Topics

 • See the “Changing Your Personal Profile Settings” section on page 15-2 for 
information about how to change the language in your profile.

 • For information about how to change the language of the meeting prompts 
that you hear on the telephone, see the Telephone Commands for 
Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.htm
l.
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Leaving the Web Meeting Room
This topic describes how to leave a meeting without ending it.

Procedure

Click the Close (X) button in the upper-right corner of the web meeting room 
window.

Troubleshooting Tips

If the Close (X) button is not visible in the upper-right corner of the web meeting 
room window, do one of the following:

If Do This

You are viewing the web meeting room 
in full screen mode and you can see the 
participant list.

Choose Meeting > Full screen.

You are viewing the web meeting room 
in full screen mode and you cannot see 
the participant list.

Click Full screen at the base of your 
screen.
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Controlling Who Is In Your Cisco Unified 
MeetingPlace Express Meeting

 • How to Lock Your Meeting, page 7-1

 • How to Remove Participants from Your Meeting, page 7-6

How to Lock Your Meeting
While a meeting is in progress, you can control access to it by locking the virtual 
web meeting room. This means that subsequent arrivals cannot enter the meeting, 
or must request permission to enter. 

 • Tips About Locking Your Meeting

 • Locking a Meeting from the Web Meeting Room, page 7-2

 • Locking a Meeting by Using Your Cisco Unified IP Phone, page 7-3

 • Handling Requests for Entry to a Locked Meeting, page 7-4

 • Changing the Locked Meeting Message and Options, page 7-5

Tips About Locking Your Meeting
In most cases, locking a meeting through any method applies to all meeting 
components: voice, video and web. However, there are some exceptions.
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 • If you lock the meeting from inside the web meeting room before anyone has 
joined the voice or video meeting, the web meeting is not locked. You will 
have to unlock and relock the meeting after someone has joined the voice or 
video meeting.

 • You cannot prevent people from requesting entry to the voice meeting.

 • Since a breakout session is a voice feature, you cannot lock it from within the 
web meeting room.

 • If you lock the meeting by using your telephone or the Cisco Unified 
MeetingPlace Express Phone View on your Cisco Unified IP Phone, you 
cannot prevent people from requesting entry. You also cannot specify the 
message that new arrivals hear or see when they attempt to join the meeting.

You can mix and match the methods you use to perform various actions, as long 
as the method you use can perform the feature that you want to use. For example, 
you can use the feature in the web meeting room to lock the meeting, and admit 
participants by using your telephone keypad. 

Locking a Meeting from the Web Meeting Room

Tip You can also lock your meeting by pressing #41 on your telephone keypad.

Before You Begin

 • You must be in the web meeting room. 

 • You must be a moderator.

Procedure

Step 1 Locate the menu bar.

Step 2 Choose Meeting > Lock Meeting.

Step 3 Perform one of the following actions:
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Step 4 (Optional) Modify the default message that new arrivals will see and click Set As 
Default Message.

Step 5 Click OK.

Troubleshooting Tips

If your meeting is currently locked, choose Meeting > Lock Meeting again to 
unlock it.

Related Topics

For a quick list of commands you can initiate by telephone during a meeting, see 
the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html.

Locking a Meeting by Using Your Cisco Unified IP Phone

Before You Begin

 • You must have the Cisco Unified MeetingPlace Express Phone View installed 
on your Cisco Unified IP Phone.

To Do This

Selectively admit participants. Check Incoming participants can 
request entry.

You will see a message on your screen 
when a participant requests entry.

Restrict participants from requesting 
entry.

Uncheck Incoming participants can 
request entry.

New participants cannot request entry 
to the web meeting until you unlock the 
meeting. 

Note Participants entering the voice 
meeting can still request entry.
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 • You must be the meeting owner.

 • Complete the “Viewing Meeting Details On Your Cisco Unified IP Phone” 
section on page 14-6 for the meeting that you want to lock.

Procedure

Step 1 Press the Lock softkey. 

If you do not see a Lock softkey, press more.

Step 2 Read the screen that appears, then press Lock again.

Troubleshooting Tips

If your meeting is currently locked, press the Unlock softkey again to unlock it.

Related Topics

 • Handling Requests for Entry to a Locked Meeting, page 7-4.

Handling Requests for Entry to a Locked Meeting 
A person who dials in to a meeting that is locked can request entry to the meeting. 
You can accept or deny that request from both the telephone and the web meeting 
room.

 • From the telephone, if you do not want to admit the person who is requesting 
entry simply ignore the request.

 • To admit the person from your telephone keypad, press #42 and follow any 
prompts that you hear.

 • From the web meeting room, you will see entry requests at the top and bottom 
of your web meeting room window.

Before You Begin

You must be the person who locked the meeting.

Procedure

When you see an entry request , perform one of the following actions:
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Troubleshooting Tips

If you have the Cisco Unified MeetingPlace Express Add-in installed, multiple 
notifications will stack up at the bottom of your screen. You can respond to each 
individually.

Related Topics

For a quick list of commands you can initiate by telephone during a meeting, see 
the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html.

Changing the Locked Meeting Message and Options
When people try to join a web meeting that is locked, they see a message that you 
can specify. You can also specify whether or not to allow new arrivals to request 
entry to the meeting.

Before You Begin

 • You must be the person who locked the meeting.

 • You must be in the web meeting room.

To Do This

Scroll through multiple requests. Click the arrows in your notification to 
view the names of the people who are 
requesting entry.

Admit a person into the meeting. Click Accept.

Deny entry and notify the requestor. Click Decline.

Close a notification and decline the 
request.

Close the notification by clicking the X 
in the top corner.

Unlock the meeting and admit all new 
arrivals.

Choose Meeting > Lock Meeting 
from the web meeting room menu bar.
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Procedure

Step 1 Locate the menu bar.

Step 2 Roll your mouse over the locked-meeting icon on the right .

Step 3 Click the appropriate link to make any of the following changes:

 • Allow or disallow new arrivals to request entry.

 • Change the message that new arrivals see.

 • Unlock the meeting to remove the entry restriction.

How to Remove Participants from Your Meeting
Besides locking your meeting to prevent future access, you can also remove 
participants who are already in your meeting.

 • Removing Participants from the Web Meeting Room, page 7-6

 • Removing a Participant from Your Cisco Unified IP Phone, page 7-7

Removing Participants from the Web Meeting Room
Removing a participant from the web meeting room removes that participant from 
all components of the meeting unless the participant dialed in separately to join 
the voice or video component. In this case, the participant may appear twice in the 
participant list, and you must remove each instance of that participant separately.

Tip You can also remove the most recent person who joined by pressing #43 on your 
telephone keypad.

Before You Begin

You must be a moderator.
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Procedure

Step 1 Locate the Participant List pod.

Step 2 Click the name of the participant that you want to remove.

 • Windows users: Press Ctrl on your keyboard then click to select multiple 
participants. 

 • Mac users: Press command on your keyboard then click to select multiple 
participants.

Note Make sure that you have selected all instances of the participant that you 
want to remove since participants may appear as separate web 
participants and voice or video participants.

Step 3 Click  > Remove Selected Participant.

Step 4 (Optional) Lock the meeting to prevent the removed participant from reentering 
the meeting.

Related Topics

 • How to Lock Your Meeting, page 7-1

Removing a Participant from Your Cisco Unified IP Phone

Before You Begin

 • You must have the Cisco Unified MeetingPlace Express Phone View installed 
on your Cisco Unified IP Phone.

 • You must be the meeting owner.

 • Complete the “Viewing Participant Lists and Details On Your Cisco Unified 
IP Phone” section on page 14-7 for the participant you want to remove.

Procedure

Step 1 Press the Drop softkey.
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Step 2 Read the message that appears on the phone screen.

Step 3 Press Close to return to the roster.

Step 4 (Optional) Lock the meeting to prevent the removed participant from reentering 
the meeting.

Related Topics

 • How to Lock Your Meeting, page 7-1
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Managing Your Cisco Unified 
MeetingPlace Express Meeting

You must a moderator or presenter to complete any of these tasks.

 • Resizing a Pod Area, page 8-2

 • Muting and Unmuting Participants from the Web Meeting Room, page 8-2

 • Muting and Unmuting a Participant from Your Cisco Unified IP Phone, 
page 8-3

 • Changing the Volume of Individual Participants, page 8-4

 • Enabling Private Chat for the Audience, page 8-5

 • Merging Two Instances of a Participant in the Participant List, page 8-6

 • Changing the Permission Level of Participants in the Web Meeting Room, 
page 8-7

 • Renaming Participants in the Web Meeting Room, page 8-8

 • Changing Your View of the Web Meeting Room, page 8-8

 • Setting the Screen Resolution of the Web Meeting Room, page 8-9

 • Breaking Out from the Main Meeting
8-1
 MeetingPlace Express Release 2.x



Chapter 8      Managing Your Cisco Unified MeetingPlace Express Meeting
    Resizing a Pod Area
Resizing a Pod Area
The full meeting room has four pod areas: Participant List pod, Share pod, Chat 
pod, and Note pod. Follow this procedure to resize any of these areas for better 
viewing.

Before You Begin

You must be a moderator or presenter.

Procedure

Step 1 Determine which pod you want to resize.

Step 2 Click  in the top right corner to maximize or restore the size of the pod.

Muting and Unmuting Participants from the Web 
Meeting Room

Muting a participant during a meeting affects sounds coming from their phone or 
video endpoint.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Choose the participants that you want to mute:
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Step 3 Click .

Step 4 Click  to set chosen participants to mute.

Step 5 Click elsewhere on the screen to hide the volume slider.

Selected participants appear as muted in the participant list.

Related Topics

 • Muting and Unmuting a Participant from Your Cisco Unified IP Phone, 
page 8-3

Muting and Unmuting a Participant from Your 
Cisco Unified IP Phone

Before You Begin

 • You must be the meeting owner.

 • You must be in the web meeting room.

To Do This

Mute a single participant. Click the name of the participant.

Mute multiple participants. Windows users: Press Ctrl on your 
keyboard then click the names of the 
participants that you want to mute. 

Mac users: Press Command on your 
keyboard instead of Ctrl. 

Mute all participants. 1. Click  > Select All.

2. Ctrl-click or Command-click 
those participants you want to 
deselect, such as yourself and 
web-only participants.
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 • You must have the Cisco Unified MeetingPlace Express Phone View installed 
on your Cisco Unified IP Phone.

 • Complete the “Viewing Participant Lists and Details On Your Cisco Unified 
IP Phone” section on page 14-7 for the participant you want to mute. 

Procedure

Troubleshooting Tips

You can only mute or unmute yourself if you joined the voice meeting as a 
profiled user by using your Cisco Unified IP Phone.

Related Topics

 • Muting and Unmuting Participants from the Web Meeting Room, page 8-2

Changing the Volume of Individual Participants
You can modify the volume coming from the phone or video endpoints of other 
participants. All participants hear the change.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Choose the participant whose volume you want to change.

To Do This

Mute a participant. Press the Mute softkey.

Uunmute a participant. Press the Unmute softkey.

Return to the roster. Press the Close softkey.
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Step 3 Click  and adjust the volume slider.

Step 4 Click elsewhere on the screen to hide the volume slider.

Enabling Private Chat for the Audience
The web meeting room includes an integrated chat window. The default privileges 
allow users with audience permissions to send messages to either everyone or to 
presenters only. They cannot chat privately with other audience participants.

Use this procedure to allow participants with audience permissions to chat 
privately with one another.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Chat pod.

To Do This

Choose yourself. Click your name.

Choose a single participant. Click the name of the participant.

Choose multiple participants. Windows users: Press Ctrl on your 
keyboard then click the names of 
participants.

Mac users: Press Command instead of 
Ctrl.

Choose all participants. Click  > Select All.
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Step 2 Click  > Enable Private Chat for Audience to set a checkmark beside it.

Merging Two Instances of a Participant in the 
Participant List

The participant list in the web meeting room ideally displays the name of each 
participant only once. If a participant joins both the web meeting and the voice or 
video meeting as a profiled user, the two entries are automatically merged. 

However, if the participant joins either or both meetings as a guest user, the 
participant will appear twice in the participant list. If this occurs, combine the 
listings into a single entry by following this procedure.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click the web entry of the participant whom you want to merge.

Step 3 Press Ctrl on your keyboard then click the telephone entry of the same user. 

Tip Mac users: Use Command-click whenever the instructions call for a 
control-click.

Step 4 Click  to merge the two entries.
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Changing the Permission Level of Participants in the 
Web Meeting Room

Each participant enters a Cisco Unified MeetingPlace Express meeting with one 
of the following permission levels: moderator, presenter, or audience. 

If you are a moderator, you can change the permission level of any participant at 
any time during a meeting. For example, to minimize the actions available to 
participants in a meeting, you can set their permission level to audience.

Selecting multiple participants at once changes the permission level of all 
participants to the same level.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Choose your participants:

Step 3 Click .

To Do This

Choose one participant. Click the name of that participant.

Choose several participants. Windows users: Press Ctrl then click 
the names of the participants to 
change. 

Mac users: Press Command instead of 
Ctrl.

Choose all participants. 1. Click  > Select All. 

2. Ctrl-click or Command-click your 
own name to deselect yourself. 
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Step 4 Choose the new permission level.

Renaming Participants in the Web Meeting Room
If you are a moderator, you can change the names that appear in the participant 
list. For example, you can specify a conference room, a location, or a company 
instead of an individual person. You can also properly identify someone who dials 
in as a guest user.

The participant is renamed only for the duration of the current meeting.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click an entry.

Step 3 Click  > Rename Participant.

Step 4 Enter the new name.

Step 5 Click OK.

Changing Your View of the Web Meeting Room
As a moderator, you can change your view of the web meeting room so that you 
can see what participants with presenter and audience permissions can see.

Before You Begin

 • You must be a moderator.
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 • You must be in the web meeting room.

Procedure 

Related Topics

 • Seeing How Other Users See Your Shared Content, page 9-11

Setting the Screen Resolution of the Web Meeting 
Room

Moderators can set the screen resolution at which all participants view the web 
meeting room. Change this setting only if participants cannot properly view the 
default web meeting room.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

To Do This

See how presenters see the web 
meeting room.

Choose View > Presenter View.

See how audience see the web meeting 
room.

Choose View > Audience View.

Return to moderator view. Choose View > Moderator View.

Note You can only return to 
moderator view if you are the 
meeting owner. If you are not 
the meeting owner, ask another 
moderator in the meeting to 
reinstate you as a moderator.
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Procedure

Step 1 Choose Meeting > Room Screen Resolution, then choose an option.

Choose a smaller resolution if participants are experiencing bandwidth problems. 
A web meeting room set at 640x480 generates less than a third of the network 
traffic of 1280x1024.

Step 2 (Optional) If you chose Custom, enter a width and height.

Step 3 Click OK.

Breaking Out from the Main Meeting
A breakout session is a meeting within a meeting. It is voice and video only. This 
feature is useful if you want to meet privately with other participants during the 
larger meeting to, for example, take a discussion offline and return to the main 
meeting with a decision. Any participant in a meeting can start or join a breakout 
session.

Note You cannot record a breakout session. Only the main meeting room can be 
recorded.

Before You Begin

 • Decide, with other participants, the number of your breakout session 
(between 1 and 9).

 • Make sure that you are in the web meeting room.

Procedure

Step 1 Press #1, then follow the instructions that you hear.

Step 2 Press #10 to leave the breakout session and return to the main meeting.
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Troubleshooting Tips

Any participant in a breakout session can lock that session by pressing #41 on 
their telephone keypad. Once a session is locked, you cannot selectively admit 
participants and participants cannot request entry. Participants who try to join a 
locked breakout session will automatically be returned to the main meeting.

To allow new participants to join your breakout session, unlock the session by 
pressing #41 again.

Related Topics

For a quick list of commands you can initiate by telephone during a meeting, see 
the Telephone Commands for Cisco Unified MeetingPlace Express at: 
http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html.
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Presenting and Working with Shared 
Content in Cisco Unified 
MeetingPlace Express

 • How to Share a Desktop, Window, or Application, page 9-1

 • How to Annotate Shared Content, page 9-7

 • How to Control How Others View Shared Content, page 9-11

How to Share a Desktop, Window, or Application
If you are a moderator or presenter, you can demonstrate applications, display one 
or more documents, or show your desktop to all participants in a web meeting 
room. This is called screen sharing. Any changes that the presenter makes to a 
shared application, document, or desktop are visible to all participants in their 
browsers. Related windows, such as dialog boxes, are also visible to meeting 
participants.

Any overlapping windows from applications that are not selected for sharing 
appear to viewers as a blue cross-hatch pattern.

 • Preparing to Share Content, page 9-2

 • Sharing a Screen During a Meeting, page 9-3

 • Changing the Screen-Sharing Source, page 9-4

 • Sharing Your Screen with Two Monitors, page 9-4
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 • Sharing Control of Your Screen with Another Presenter, page 9-5

 • Requesting Control of a Shared Screen, page 9-5

 • Ending a Screen Sharing Session, page 9-6

Preparing to Share Content
Before you can share your desktop, an application or anything else in a web 
meeting, you must first install the Cisco Unified MeetingPlace Express Add-in. 

You can install the Add-in at any time, either before you need to share, or the first 
time you try to share content. After you install the Add-in, you do not need to 
install it again.

Before You Begin

See if there is a Download the Add-in button in your web meeting room. If you 
do not see this button, you have the Add-in installed already. Skip this procedure.

Procedure

Step 1 Click .

Step 2 Follow the instructions in the install wizard.

Step 3 If you are unable to download the Cisco Unified MeetingPlace Express Add-In or 
see an error that says “Adobe Flash: A download error occurred. Try to download 
again?” go to a web browser and enter one of the following:

For Windows: <server name>/public/ciscounifiedaddin6x5-installer.exe, where 
server name is the name of your Cisco Unified MeetingPlace Express server

For MAC: <server name>/public/CiscoUnifiedaddin6x5-installer.z, where 
server name is the name of your Cisco Unified MeetingPlace Express server

Step 4 Save the file.

Step 5 Navigate to where you saved the file and execute it.

Step 6 Follow the steps in the Cisco Unified Presenter Add-In Setup Wizard to complete 
the installation.
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Related Topics

 • Cannot Install Cisco Unified MeetingPlace Express Add-in, page 16-17

Sharing a Screen During a Meeting
You can share a document, application, or your desktop.

Before You Begin

 • You must be a moderator or presenter. Roll your mouse over the icons to the 
left of your name to see your permission level.

 • You must be in the full meeting room or the share-only meeting room.

 • Install the Cisco Unified MeetingPlace Express Add-In. See the “Preparing 
to Share Content” section on page 9-2.

 • Open the window or application that you want to share.

Procedure

Step 1 Click Start Screen Sharing.

Step 2 Choose what you want to share.

Step 3 Click Share.

Troubleshooting Tips

 • While you are sharing, make sure that the shared content remains visible on 
your screen. For meeting participants to see a window, it must be in full view 
on your desktop.

 • If a window that you did not select for sharing moves over your shared screen, 
the parts of the shared content that are covered will appear to participants as 
a blue cross-hatch pattern.

Related Topics

 • Sharing Problems, page 16-18
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Changing the Screen-Sharing Source
You can change the source of your screen-sharing broadcast while you are sharing 
your screen.

Before You Begin

 • Make sure that you are sharing your screen. See the “Sharing a Screen During 
a Meeting” section on page 9-3 for instructions.

 • You must be a moderator or presenter. Roll your mouse over the icons to the 
left of your name to see your permission level.

 • You must be in the full meeting room or the share-only meeting room.

Procedure

Step 1 Locate the application task bar at the bottom of your screen.

Step 2 Click  > Choose Window to Share.

Step 3 Click Desktop, Window, or Application.

Step 4 Select the specific desktop, window, or application to share.

Step 5 Click Share.

Sharing Your Screen with Two Monitors
If your system is set up with two monitors, for example, if you use both a laptop 
and a PC monitor at the same time, you can still share your screen. However, if 
you choose to share your desktop, only one desktop is shown at a time.

Before You Begin

 • Make sure that you are sharing your screen. See the “Sharing a Screen During 
a Meeting” section on page 9-3 for instructions.

 • You must be a moderator or presenter. Roll your mouse over the icons to the 
left of your name to see your permission level.

 • You must be in the full meeting room or the share-only meeting room.
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Procedure

Step 1 Locate the application task bar at the bottom of your screen.

Step 2 Click  > Choose Window to Share.

Step 3 Click Desktop, Window, or Application.

Step 4 Select the specific desktop, window, or application to share.

Step 5 Click Share.

Sharing Control of Your Screen with Another Presenter
While screen sharing, you can pass control of the shared desktop, window, or 
application to another presenter. The presenter must request control before you 
can hand over your shared screen to them.

Procedure

Step 1 Start sharing your computer screen in a meeting. When another presenter requests 
control of your screen, you see a request message in the upper-right corner of the 
meeting room window.

Step 2 Choose the applicable option:

 • Accept—Use to grant control of your screen to the requesting participant.

 • Decline—Use to deny control of your screen to the participant.

Requesting Control of a Shared Screen
As a moderator or presenter, you can request control of the screen of another 
presenter or moderator.
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Procedure

Step 1 Click Request Control on the Share tool control strip.

If the request is accepted, a message informs you that you have been granted 
control of the screen. The Request Control button becomes a Release Control 
button. You can now take control of the shared screen.

Step 2 To return control of the shared screen to the original presenter, click Release 
Control on the Share tool control strip.

Ending a Screen Sharing Session
You can stop sharing your screen at any time. If you are sharing multiple windows 
or applications, you can stop sharing some windows while continuing to share 
others.

Before You Begin

You must be sharing your screen. See the “Sharing a Screen During a Meeting” 
section on page 9-3 for instructions.

Procedure

To Do This

Stop sharing a particular 
window

1. Bring that window to the front of your screen.

2. Click the arrow beside the red Stop Sharing 
button.

3. Choose Stop Sharing This Window.

Stop sharing all content Click Stop Sharing in the upper-right corner of the 
shared window or application.
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How to Annotate Shared Content
If you are a presenter or moderator, you can use an overlay to superimpose 
annotations on shared content during a meeting. This content can be a file, such 
as a Microsoft Word file, or a blank document or window if you want to simulate 
a whiteboard.

Because annotations are created on a transparent layer above your document, the 
original document is not altered.

Note You do not need to have the Cisco Unified MeetingPlace Express Add-in installed 
to make annotations. 

 • Setting Up for Annotation, page 9-7

 • Creating an Annotation, page 9-8

 • Ending an Annotation Session, page 9-10

Setting Up for Annotation

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the full meeting room or the share-only meeting room.

 • Share the window or application that you want to annotate. See the “Sharing 
a Screen During a Meeting” section on page 9-3 for instructions.

Procedure

Step 1 Bring the shared window or application to the front.

Note You can only make annotations on one window at a time. If you are 
sharing multiple windows, you can arrange the windows on your screen 
so that more than one window is showing. All visible shared windows will 
appear on the screen when you annotate.
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Step 2 Click the arrow beside the red Stop Sharing button and choose Pause and 
Annotate.

If you are sharing an application with multiple open windows, the red Stop 
Sharing and arrow buttons are visible on all windows but active only on the 
window that is in front.

Step 3 Wait a few moments.

 • The web meeting room comes to the front of your screen with the shared 
document visible.

 • The annotation toolbar appears in the lower-right corner of the web meeting 
room.

You and other moderators and presenters can begin to annotate.

Related Topics

 • Creating an Annotation, page 9-8

Creating an Annotation
When you annotate, you can choose from a variety of drawing tools and specify 
the characteristics of those tools. If multiple participants are going to annotate on 
a single window, they can choose colors to distinguish their annotations from 
others.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the full meeting room or the share-only meeting room.

 • Set up your web meeting room to begin annotations. See the “Setting Up for 
Annotation” section on page 9-7.

Procedure

Step 1 Click Annotation Tools.

Step 2 Click the tool that you want to use.
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To Click This

Select a shape or area of the annotation layer.

Tip Click and drag your mouse to create a rectangle 
around the section you want to select. Shift-drag 
a corner control point to maintain the aspect ratio 
when resizing. To add a shape to the selection, 
Shift-click the shape.

 

Create a freehand line.  

Create a thicker line with the appearance of a felt-tip 
marker.

 

Draw a straight line between two points.

Tip To make the line move in 45 degree increments, 
press the Shift key while drawing.

 

Create square and rectangle shapes.

Tip To draw a square, press the Shift key while 
drawing. 

To expand it, click , then the shape, then a 
white dot on the shape and drag it.

 

Create circle and ellipse shapes.

Tip To draw a circle, press the Shift key while 
drawing. Drag to expand the shape.

  

Create a floating multiline text character.

Tip Click and drag to create a text area into which you 
can type.

  

Leave a check mark, arrow, star, or cross on the screen. 
The default stamp is an arrow.

 

9-9
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 9      Presenting and Working with Shared Content in Cisco Unified MeetingPlace Express
    How to Annotate Shared Content
Step 3 Begin annotating.

Related Topics

 • Ending an Annotation Session, page 9-10

Ending an Annotation Session

Procedure

Undo the previous action.

You can undo the following actions: drawing a shape, 
moving a shape, resizing a shape, clearing the annotation 
layer, and changing a property of a shape. There is no 
limit to the number of times that you can perform this 
operation.

 

Redo a previous action.  

Clear all annotations made in the meeting. 

Tip To delete only one annotation, select it and click 
Delete.

  

Print the Share pod, visible shared content, and 
associated annotations.

 

To Click This

To Do This

End the annotation session and display 
the shared window without 
annotations.

Click Resume at the bottom of the 
Share pod.

End an annotation session when 
another person is sharing.

Start sharing a document on your own 
computer.
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How to Control How Others View Shared Content
By default, the full meeting room displays everything in your web meeting room 
including shared content and all pods. However, you can set the web meeting 
room to display nothing but the shared content and related annotations. This is 
called full screen mode.

Displaying shared content in full-screen mode hides the following elements from 
the view of all participants, including yourself:

 • The Participant List pod, Chat pod, and Note pod.

 • All other applications on each computer.

 • All elements of the operating system, such as the Start menu in Windows 
operating systems and the Close Window button on the title bar of the web 
meeting room browser window. 

Users can still use their operating system keyboard commands, such as 
Alt-Tab on Windows.

Note Participants with moderator or presenter privileges can control their view of the 
web meeting room regardless of the changes you make. If you are a moderator and 
you need to prevent participants from changing their view, you must first change 
their permission level to audience. See the “Changing the Permission Level of 
Participants in the Web Meeting Room” section on page 8-7.

 • Seeing How Other Users See Your Shared Content, page 9-11

 • Enabling Audience to Control Their View of Shared Content, page 9-12

 • Displaying Shared Content Full Screen to All Participants, page 9-13

Seeing How Other Users See Your Shared Content
To see how the entire web meeting room appears to participants with other 
permission levels, see the “Changing Your View of the Web Meeting Room” 
section on page 8-8.

To see how the content being shared appears to your viewers, follow this 
procedure.
9-11
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 9      Presenting and Working with Shared Content in Cisco Unified MeetingPlace Express
    How to Control How Others View Shared Content
Before You Begin

 • Share your screen. See the “Sharing a Screen During a Meeting” section on 
page 9-3 for instructions.

 • You must be using the full meeting room.

Procedure

Step 1 Click  at the bottom of the web meeting room.

Step 2 Click the window or application that you are sharing to bring it to the front.

Note If you do not perform this step, the web meeting room covers the shared 
window or application, so you and your viewers see only the blue 
cross-hatch pattern.

Enabling Audience to Control Their View of Shared Content 
You can specify whether participants with audience permissions can control their 
own full-screen view of shared content.

Note Participants with moderator or presenter privileges can always control their own 
view unless you change their permission level to audience.

Before You Begin

 • You must be a moderator or presenter.

 • You must be using the full meeting room.

Procedure

Step 1 Locate the Share pod.

Step 2 Click the arrow next to the Full Screen button at the bottom left.
9-12
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 9      Presenting and Working with Shared Content in Cisco Unified MeetingPlace Express
    How to Control How Others View Shared Content
Step 3 Check Enable Full Screen toggle for audience. 

Troubleshooting Tips

If you do not want participants with audience permission to control their display 
of shared content, uncheck Enable Full Screen toggle for audience.

Displaying Shared Content Full Screen to All Participants
Follow this procedure to enlarge the Share pod so that the shared content fills the 
entire screen of each participant.

Note Participants with moderator or presenter privileges can always control their own 
view of shared content. To restrict them from changing their view, change their 
permission level to audience.

Before You Begin

 • You must be a moderator or presenter.

 • You must be using the full meeting room.

Procedure

Step 1 Locate the Share pod.

Step 2 Click the arrow next to the Full Screen button at the bottom left.

Step 3 Check Presenter’s changes affect everybody.

Step 4 Click Full Screen.

Troubleshooting Tips

To restore the view of all web meeting room functions to all participants, uncheck 
Presenter’s changes affect everybody; then, click Full Screen again.
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Sending Messages in the 
Cisco Unified MeetingPlace Express 
Web Meeting Room

You can use text or icons to communicate with other participants in the 
Cisco Unified MeetingPlace Express web meeting room while a meeting is in 
progress.

 • Displaying or Clearing an Icon Next to Your Name, page 10-1

 • Clearing an Icon Next to the Name of Another Participant, page 10-2

 • Sending a Text Message in the Chat Pod, page 10-3

 • Changing the Size of Chat Text, page 10-4

 • Clearing Chat Messages, page 10-4

 • Creating a New Note, page 10-5

 • Choosing Which Note to Display, page 10-6

Displaying or Clearing an Icon Next to Your Name
Give feedback or make certain requests by displaying an emoticon beside your 
name in the participant list. You or a moderator can clear your icon message at 
any time during a meeting.
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Before You Begin

You must be in the web meeting room. 

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click My Status.

Step 3 Choose the icon that you want to show.

Step 4 Choose Clear My Status to clear the icon.

Related Topics

 • Clearing an Icon Next to the Name of Another Participant, page 10-2

Clearing an Icon Next to the Name of Another 
Participant

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Participant List pod.

Step 2 Click the name of a participant.

Step 3 Click  > Clear User Status.

Related Topics

 • Displaying or Clearing an Icon Next to Your Name, page 10-1
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Sending a Text Message in the Chat Pod
You can use the Chat pod to compose a text message and send it to a specific 
participant, to all presenters at the meeting, or to all meeting participants. When 
you receive a chat message from another participant, your chat pod shows the 
name of the sender and the message.

Before You Begin

You must be in the web meeting room.

Procedure

Step 1 Locate the Chat pod.

Step 2 Click the text box to reveal a cursor. 

Tip The text box is the smaller of the two boxes in the Chat pod.

Step 3 Type your message text.

Step 4 Choose a recipient in the To: drop-down menu.

Step 5 Click the arrow button next to the text box to send your message.

Troubleshooting Tips

All participants can send text messages in the Chat pod by default. If you cannot 
send a text message and have audience permissions, it is possible that a meeting 
moderator or presenter has disabled private chat for participants with your 
permission level. If this is not the case, contact your system administrator.

Related Topics

 • Changing the Size of Chat Text, page 10-4

 • Clearing Chat Messages, page 10-4

 • Enabling Private Chat for the Audience, page 8-5
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Changing the Size of Chat Text
The text size you choose affects all meeting participants.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Chat pod.

Step 2 Click  > Text Size.

Step 3 Choose a text size.

Related Topics

 • Sending a Text Message in the Chat Pod, page 10-3

 • Clearing Chat Messages, page 10-4

Clearing Chat Messages
While you are in the web meeting room, all of the messages that you send and 
receive during the meeting remain visible in the chat window by default. When 
you leave the web meeting room, all private messages and messages sent to 
presenters are cleared from your Chat pod while messages sent to everyone 
remain in the chat window of all participants. 

However, if you are a moderator or presenter, you can clear all messages for all 
participants.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.
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Procedure

Step 1 Locate the Chat pod.

Step 2 Click  > Clear Chat.

Related Topics

 • Sending a Text Message in the Chat Pod, page 10-3

 • Changing the Size of Chat Text, page 10-4

Creating a New Note
If you are a moderator or presenter, you can create a note to show information to 
other participants during a meeting. The note remains visible throughout the 
meeting or until another participant edits it, clears it, or displays a different note. 

All of the text in a note uses the same formatting. If you have more than one note, 
each note can have different formatting.

Each note you create is assigned a consecutive number.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Note pod.

Step 2 Click  > New Note.

Step 3 Click into the note and type your note.

Step 4 (Optional) modify your note.
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Related Topics

 • Choosing Which Note to Display, page 10-6

Choosing Which Note to Display
If you have more than one note, you can change which note is visible to 
participants at any time.

Before You Begin

 • You must be a moderator or presenter.

 • You must be in the web meeting room.

Procedure

Step 1 Locate the Note pod.

Step 2 Click  > Select Note.

Step 3 Select the number of the note that you want to display.

To Do This

Edit it. Click anywhere inside the note and 
modify the text.

Change the text size. 1. Click Pod options > Text Size.

2. Choose a text size.

Change the text alignment. 1. Click Pod options.

2. Choose an alignment option.
10-6
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 10      Sending Messages in the Cisco Unified MeetingPlace Express Web Meeting Room
    Choosing Which Note to Display
Note The name of the note that is currently displayed is omitted from the 
pop-up menu.

Related Topics

 • Creating a New Note, page 10-5
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Recording a Cisco Unified 
MeetingPlace Express Meeting

 • Things to Know Before Recording a Meeting, page 11-1

 • Recording a Meeting from the Web Meeting Room, page 11-2

 • Recording a Meeting from Your Cisco Unified IP Phone, page 11-2

 • Listening to Meeting Recordings, page 11-3

Things to Know Before Recording a Meeting
Be aware of the following before recording a meeting:

 • Only the voice portion of a meeting is recorded. Make sure that you archive 
any shared documents or screen captures of annotations separately.

 • At least one participant must be in the voice meeting before you can start 
recording.

 • You cannot record a breakout session. Only the voice meeting in the main web 
meeting room is recorded.

 • Recordings can be stopped and started multiple times during a meeting.

 • Recordings typically require 16Kbps of disk space.
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Recording a Meeting from the Web Meeting Room
Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

 • Read the “Things to Know Before Recording a Meeting” section on 
page 11-1.

Procedure

Step 1 Locate the menu bar at the top of your screen.

Step 2 Choose Meeting > Record Meeting (Voice).

Step 3 (Optional) Choose Meeting > Record Meeting (Voice) again to stop recording.

Troubleshooting Tips

When you begin recording,  appears at the right side of the menu bar at the 
top of the screen and a check mark appears beside the Record Meeting (Voice) 
option.

Related Topics

 • Listening to Meeting Recordings, page 11-3

Recording a Meeting from Your Cisco Unified IP 
Phone

Before You Begin

 • You must have Cisco Unified MeetingPlace Express Phone View installed on 
your Cisco Unified IP Phone.

 • You must be the meeting owner.
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 • Read the “Things to Know Before Recording a Meeting” section on 
page 11-1.

 • Complete the “Viewing Meeting Details On Your Cisco Unified IP Phone” 
section on page 14-6 for the meeting that you want to record.

Procedure

Step 1 Press the Record softkey. 

If you do not see the Record softkey, press more.

Step 2 Read the screen that appears, then press Record.

Step 3 Press Stop to stop recording the meeting.

Listening to Meeting Recordings
You can choose to listen to a meeting recording as soon as it becomes available. 
Meeting recordings are available within an hour after the meeting ends and are in 
MP3 format.

If the meeting associated with the recording was restricted to profile users or by 
a password, you will require this additional information to listen to the recording. 

Before You Begin

 • Make sure that you have a media player that can play MP3 files installed on 
your computer. Many media players are available as free downloads from the 
internet, such as Windows Media Player, Apple QuickTime, Apple iTunes, 
and Real Media Player.

 • Find the meeting that you want to listen to. See the “Finding a Meeting or 
Recording” section on page 4-1.

 • Know your username and password (if required).

 • Know the meeting password (if required).
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Procedure

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 (Optional) Enter the meeting password if required.

The Meeting Details page appears.

Step 3 Click Play Recording.

Tip The system administrator may purge meeting recordings after a certain 
time. To ensure that you have a recording available for future reference, 
download and save it after it becomes available.

Troubleshooting Tips

 • If you see a message that tells you to log in, you must log in, then return to 
this Meeting Details page. After you log in and find this page again, you will 
see the Play Recording button.

 • If the meeting status column does not show Recorded, one of the following 
situations may be true:

 – The meeting has not yet ended.

 – The meeting has recently ended and the recording is not yet available.

 – The meeting was not recorded.

 – The recording has been purged from the system and is no longer 
available.

 • If you do not see an option to save the recording as a file, see the 
documentation for your browser, your operating system, or the application on 
your computer that plays MP3 recordings.
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Extending or Ending Your Cisco Unified 
MeetingPlace Express Meeting

 • When Meetings Are Extended, page 12-1

 • When Meetings Automatically End, page 12-2

 • Ending a Meeting from the Web Meeting Room, page 12-3

 • Ending a Meeting from the Meeting Details Web Page, page 12-4

When Meetings Are Extended
Meetings are automatically extended if the following conditions are all true:

 • The Cisco Unified MeetingPlace Express system administrator has allowed 
meetings to be extended.

 • Two or more participants remain in either the voice/video or web meeting. 
For reservationless meetings, web meetings can be extended only if no 
participants ever joined the voice or video meeting.

 • Cisco Unified MeetingPlace Express resources are available to continue the 
meeting.

The maximum extension is 24 hours for voice or video meetings and 12 hours for 
web meetings. (If a system administrator has created a continuous meeting, there 
is no limit.)
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Participants will not hear an announcement if an extension occurs. If a meeting 
cannot be extended, participants will hear a warning message a few minutes 
before the meeting ends.

When Meetings Automatically End
Meetings end automatically when they meet certain conditions. Otherwise, an 
authorized person must end them. If a meeting is about to end automatically, 
participants will hear a warning message a few minutes before the meeting ends.

Meetings end according to the following table:

Meeting Type
When It Ends According to the 
Allotted Time When It Ends Immediately

Reservationless 
meetings

At least one person remains in 
the meeting from any access 
point (web, voice, or video).

An authorized person 
performs an action to end 
the meeting.

or

The last participant on the 
telephone hangs up. (The 
voice, video, and web 
portions of the meeting all 
end regardless of the number 
of participants that remain in 
the web meeting room.)

Scheduled 
meetings

At least one person remains in 
the meeting from any access 
point (web, voice, or video).

or

Another meeting with the 
same meeting ID is scheduled 
to start immediately after the 
current meeting is scheduled 
to end. 

An authorized person 
performs an action to end 
the meeting.
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If you have privileges to end a meeting, you can end the meeting at any time. This 
is especially useful if your account is billed by the minute and you want to stop 
accumulating charges as soon as your meeting ends. Also, ending a meeting as 
soon as you no longer need it makes meeting resources available to other people 
in your organization who may need them.

Related Topics

 • Ending a Meeting from the Web Meeting Room, page 12-3

 • Ending a Meeting from the Meeting Details Web Page, page 12-4

About Ending a Share-Only Meeting 
In a share-only meeting, meeting participants must request that the meeting end 
from inside the voice portion of the Cisco Unified Personal Communicator 
meeting. The Cisco Unified MeetingPlace Express system ends the share-only 
web meeting and removes all participants from the meeting room. 

See the user documentation for Cisco Unified Personal Communicator for more 
information.

Ending a Meeting from the Web Meeting Room
Ending a meeting from the web meeting room ends both the web meeting and the 
associated voice and video meetings.

Tip If you are a profiled user on the telephone, you can also end all components of 
your meeting by pressing #83; then, following the prompts that you hear.

Before You Begin

 • You must be a moderator.

 • You must be in the web meeting room.

Procedure

Step 1 Choose Meeting > End Meeting.
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Step 2 (Optional) Change the message that you want participants to see after this meeting 
ends.

Step 3 (Optional) Check the check box and enter a URL that you want to display to 
participants after the meeting ends. This URL will open in a new browser window 
on the screens of all participants.

Step 4 Click OK. 

Ending a Meeting from the Meeting Details Web 
Page

Cisco Unified MeetingPlace Express always opens two browser windows on your 
desktop. One is the web meeting room; the other is the Meeting Details web page. 

Note An authorized user can end a meeting without joining it.

Before You Begin

 • You must be the meeting owner, the delegate of the meeting owner, an 
attendant, or a system administrator.

 • You must be in the web meeting room.

Procedure

Step 1 Click the Meeting Details web page.

Step 2 Click End Meeting.
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Managing the Cisco Unified 
MeetingPlace Express Web Meeting 
Room Connection

This section describes how to manage the network connection to the 
Cisco Unified MeetingPlace Express web meeting room for yourself and other 
participants in your meetings.

 • Checking Your Connection to the Web Meeting Room, page 13-1

 • Changing Your Connection Speed to the Web Meeting Room, page 13-2

 • Reconnecting to the Web Meeting Room, page 13-3

 • Monitoring Connection Status Indicators of All Participants, page 13-4

 • Optimizing the Web Meeting Room Bandwidth, page 13-6

Checking Your Connection to the Web Meeting 
Room

The quality of your connection to the web meeting room determines how well you 
can see what is happening in the meeting.

Procedure

Step 1 Locate the menu bar at the top of the web meeting room.
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Step 2 Look at the far right end to determine your connection status. 

Step 3 (Optional) Click the colored indicator bar to display more information about your 
connection.

 • Read details about your connection status that appear in a pop-up window 
near the top right corner of the web meeting room web page.

 • Follow any instructions that you see.

Changing Your Connection Speed to the Web 
Meeting Room

Changing your connection speed can improve your experience in the web meeting 
room by making sure that Cisco Unified MeetingPlace Express does not send too 
much data to you too fast. Set the connection speed to match the bandwidth at 
which your computer is connected to the Internet.

Procedure

Step 1 Locate the menu bar.

Option Description

Green bar The room connection is optimal.

Yellow bar Network congestion. You may have 
difficulty viewing the web meeting 
room properly.

Red bar You have been disconnected from the 
web meeting room because of network 
problems.

Skip the rest of this procedure and see 
the “Reconnecting to the Web Meeting 
Room” section on page 13-3.
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Step 2 Choose Meeting > My Connection Speed.

Step 3 Choose the type of connection that your computer is using.

Troubleshooting Tips

 • If you are having problems viewing the web meeting room because of 
network problems, choose a speed that is slower than the speed that is 
currently selected.

 • If you choose Modem and you still have connection problems, inform a 
meeting moderator. The moderator can change the web meeting room settings 
by using procedures described in the “Optimizing the Web Meeting Room 
Bandwidth” section on page 13-6.

 • If you frequently have problems while you are connected via your company 
network, contact your Cisco Unified MeetingPlace Express system 
administrator.

Reconnecting to the Web Meeting Room
If you have lost the connection to the Cisco Unified MeetingPlace Express web 
meeting room, the connection status indicator at the right end of the menu bar at 
the top of the web meeting room page is red. Cisco Unified MeetingPlace Express 
automatically attempts to reestablish your meeting connection, or you can initiate 
reconnection.

Option Description

Modem—(Dial-up) This is the slowest type of internet 
connection.

DSL—(Broadband) This is a high-speed internet 
connection that is common in many 
small businesses and homes.

LAN This is the fastest connection. It is 
common in most company networks.
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Before You Begin

Make sure that the colored indicator at the right end of the menu bar is red.

Procedure

Step 1 Click the red connection indicator.

Step 2 Wait while Cisco Unified MeetingPlace Express initiates an attempt to bring you 
back online.

Troubleshooting Tips

If you are still unable to connect, inform a moderator of the meeting that you are 
attending.

Monitoring Connection Status Indicators of All 
Participants

If the network connection of a participant is too slow compared to the network 
connection speed and bandwidth of the web meeting room, or if activity and 
settings in the web meeting room require more bandwidth than is available, 
participants will have problems viewing and participating in the web meeting.

The following web meeting room conditions require more bandwidth:

 • Sharing complex, high-resolution, high-color images.

 • Multiple active presenters.

 • Rapid screen changes (for example, if a presenter flips slides quickly).

If you are a moderator, monitor the network connection for your participants to 
ensure that they can view and participate in the web meeting.

Before You Begin

 • Read the “Monitoring Connection Status Indicators of All Participants” 
section on page 13-4.

 • You must be a moderator.
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Procedure 

Step 1 Locate the Participant List pod.

Step 2 Click  > Show Connection Status.

A bandwidth sufficiency indicator appears to the right of each participant name.

Step 3 Use the following table to determine whether participants are able to connect 
properly to the meeting:

Troubleshooting Tips

 • If the meeting has many passive participants and only one person is sharing 
content, set the web meeting room resolution to 1024x768. See the “Setting 
the Screen Resolution of the Web Meeting Room” section on page 8-9.

 • Tell participants who are experiencing problems to reduce the speed of their 
network connection to the web meeting room. See the “Changing Your 
Connection Speed to the Web Meeting Room” section on page 13-2.

Option Description

No Icon The user has an acceptable network connection.

The connection of this user may not be adequate, and the user may 
not be able to easily view and participate in the web meeting.

(The connection bandwidth of this user is less than the current room 
bandwidth, the network that this user is on is experiencing high 
latency (between 0.2 and 4 seconds), or the network connection of 
this user is dropping 5% to 20% of packets.)

The connection of this user is insufficient, and the user cannot view 
and participate in the web meeting.

(The network latency of this user is greater than four seconds, the 
web meeting room is on a LAN and the user is connecting at modem 
speed, or the network connection of this user is dropping over 20% 
of packets.)
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 • If the preceding solutions do not solve the problem, reduce the network 
connection speed of the web meeting room. See the “Optimizing the Web 
Meeting Room Bandwidth” section on page 13-6.

Optimizing the Web Meeting Room Bandwidth
Moderators can optimize the meeting experience by setting the bandwidth of the 
web meeting room to match the average connection speed of the meeting 
participants.

Before You Begin

 • You must be in the web meeting room.

 • You must be a moderator.

Procedure

Step 1 Locate the menu bar.

Step 2 Choose Meeting > Optimize Room Bandwidth.

Step 3 Set the room connection depending on your situation:
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Troubleshooting Tips

If you try the DSL setting and problems persist, try the Modem setting.

If Do This

Participants are not experiencing connection problems. Choose LAN.

You know that participants are attending the meeting through 
a broadband internet connection.

or 

Participants experience connection problems when Optimize 
Room Bandwidth is set to LAN.

Choose DSL.

You know that participants are attending the meeting through 
a dial-up internet connection.

or 

Participants experience connection problems when Optimize 
Room Bandwidth is set to DSL.

Choose 
Modem.
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Using Cisco Unified 
MeetingPlace Express Phone View

Cisco Unified MeetingPlace Express Phone View integrates the Cisco Unified 
MeetingPlace Express application with your Cisco Unified IP Phone.

To get general information about using your Cisco Unified IP Phone, see the 
documentation at: 
http://www.cisco.com/en/US/products/hw/phones/ps379/products_user_guide_li
st.html

Note You must use the Cisco Unified MeetingPlace Express web pages to schedule 
meetings. You cannot schedule meetings through the Cisco Unified 
MeetingPlace Express Phone View.

 • Tips for Using Cisco Unified MeetingPlace Express with Your Cisco Unified 
IP Phone, page 14-2

 • Setting Up Cisco Unified MeetingPlace Express Phone View, page 14-2

 • Accessing Cisco Unified MeetingPlace Express Phone View, page 14-4

 • Viewing Lists of Meetings On Your Cisco Unified IP Phone, page 14-5

 • Viewing Meeting Details On Your Cisco Unified IP Phone, page 14-6

 • Viewing Participant Lists and Details On Your Cisco Unified IP Phone, 
page 14-7
14-1
 MeetingPlace Express Release 2.x

http://www.cisco.com/en/US/products/hw/phones/ps379/products_user_guide_list.html


 

Chapter 14      Using Cisco Unified MeetingPlace Express Phone View
    Tips for Using Cisco Unified MeetingPlace Express with Your Cisco Unified IP Phone
Tips for Using Cisco Unified MeetingPlace Express 
with Your Cisco Unified IP Phone

 • You cannot use the numbered telephone keypad to respond to a prompt if 
information about Cisco Unified MeetingPlace Express meetings or 
participants is visible on your phone screen. Do the following in this 
situation:

 – Press the * key if you want to exit the prompt menu.

 – For Cisco Unified IP Phone 7940 series and Cisco Unified IP Phone 7960 
series: Press the Services button to exit all services; then, press the 
desired numbers on the telephone keypad to respond to audible prompts.

 – For Cisco Unified IP Phone 7970 series and Cisco IP Communicator: 
Click the telephone icon at the top left of the screen; then, press the 
desired numbers on the telephone keypad to respond to audible prompts.

 • The softkeys at the bottom of the screen change depending on the information 
on the screen and your role in the meeting (for example, meeting owner, 
invited participant, current participant, or uninvolved person.)

 • You can join a meeting that is in progress or is scheduled to begin soon. The 
exact time that you can join a meeting depends on settings made by your 
system administrator.

Setting Up Cisco Unified MeetingPlace Express 
Phone View

Before You Begin

 • Obtain the following information from your system administrator:

 – The URL for setting up your Cisco Unified IP Phone services.

 – Your web username and password.

 – The name of your device or device profile. (This information pertains to 
your phone and is unrelated to your Cisco Unified MeetingPlace Express 
user profile.)

 • Log in to Cisco Unified MeetingPlace Express.
14-2
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 14      Using Cisco Unified MeetingPlace Express Phone View
    Setting Up Cisco Unified MeetingPlace Express Phone View
Procedure

Step 1 Navigate to the URL for setting up services for your Cisco Unified IP Phone.

 • This is information obtained from your system administrator.

 • Click Yes to any security alerts.

Step 2 Enter your username and password.

Step 3 Click Log On.

Step 4 Choose a device or device profile to configure.

This is information obtained from your system administrator.

Step 5 Click Configure your Cisco Unified IP Phone Services.

Step 6 Locate the Available Services field.

Step 7 Choose Cisco Unified MeetingPlace Express.

Step 8 Click Continue.

Step 9 Enter the following information:

 • Your phone extension as it appears on the screen of your Cisco Unified IP 
Phone.

 • Your Cisco Unified MeetingPlace Express username.

 • The Cisco Unified MeetingPlace Express password that is associated with 
your username.

Step 10 Click Subscribe.

Step 11 Click Log Off.

Related Topics

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22
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Accessing Cisco Unified MeetingPlace Express 
Phone View

Before You Begin

 • Read the “Tips for Using Cisco Unified MeetingPlace Express with Your 
Cisco Unified IP Phone” section on page 14-2.

 • Complete the “Setting Up Cisco Unified MeetingPlace Express Phone View” 
section on page 14-2.

Procedure

Step 1 Press Services on your Cisco Unified IP Phone.

Tip The Services button varies according to the phone model. If you cannot 
locate the correct button, see the “Setting Up Cisco Unified 
MeetingPlace Express Phone View” section on page 14-2.

Step 2 Press the up and down arrows on your phone to move the highlighted bar to the 
item that you want to select.

Step 3 Press the Select softkey. 

Depending on the list you are working with, you may be able to press other 
softkeys to perform a desired action.

Tip You can also select your service by pressing the number on your 
telephone keypad that corresponds to the item that you want to select. 

Troubleshooting Tips

 • If the item that you are looking for is not visible on the screen, use the 
following methods to locate it:

 – Press the up and down arrows on your phone to scroll through the list. 

 – Press 9 to view the next screen of items or 1 to view the previous screen. 
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Tip Not all items on a screen are visible at one time; scroll up or down to see 
all items before you view the next or previous screen.

 • Press Help to access the help system. If you do not see a Help softkey at the 
bottom of your screen, press more.

Related Topics

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22

Viewing Lists of Meetings On Your Cisco Unified IP 
Phone

Before You Begin

 • Read the “Tips for Using Cisco Unified MeetingPlace Express with Your 
Cisco Unified IP Phone” section on page 14-2.

 • Complete the “Accessing Cisco Unified MeetingPlace Express Phone View” 
section on page 14-4.

Procedure

Complete one of the following actions:

Related Topics

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22

To Do This

View meetings for today. Press the number that appears beside 
Today’s Meetings in the list.

View continuous meetings. Press the number that appears beside 
Continuous Meetings in the list
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Viewing Meeting Details On Your Cisco Unified IP 
Phone

You can view information about any meeting that appears in the list of Today’s 
Meetings or the list of continuous meetings, and for any meeting for which you 
know the meeting ID.

Before You Begin

 • Read the “Tips for Using Cisco Unified MeetingPlace Express with Your 
Cisco Unified IP Phone” section on page 14-2.

 • Complete the “Accessing Cisco Unified MeetingPlace Express Phone View” 
section on page 14-4.

Procedure

Step 1 Select your meeting.

 • If you do not know the meeting ID, do this:

1. Open a list of meetings. 

2. Select the meeting that you want to view.

 • If you know the meeting ID, do this:

1. Press 1.

2. Use the numbers on your telephone keypad to enter the meeting ID.

3. Press the Submit softkey.

Meeting details appear on the screen. Labels at the bottom of the screen indicate 
the options that you can perform by using the softkeys below the screen.

Step 2 Press the up and down arrows on your phone to scroll through the details.

Related Topics

 • Viewing Lists of Meetings On Your Cisco Unified IP Phone, page 14-5

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22
14-6
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 14      Using Cisco Unified MeetingPlace Express Phone View
    Viewing Participant Lists and Details On Your Cisco Unified IP Phone
Viewing Participant Lists and Details On Your 
Cisco Unified IP Phone

When you view a roster of current participants, it shows the participants who are 
present in the meeting at the moment that you view the list. When you view the 
invitee list, you see the names of all participants who were invited to the meeting, 
but that may not actually be in the meeting.

Note The roster never reflects name changes made to the participant list in the web 
meeting room.

Before You Begin

 • Read the “Tips for Using Cisco Unified MeetingPlace Express with Your 
Cisco Unified IP Phone” section on page 14-2.

 • Join the voice meeting as a profiled user via your Cisco Unified IP Phone.

 • Complete the “Viewing Meeting Details On Your Cisco Unified IP Phone” 
section on page 14-6 for the meeting that you want to view. The meeting must 
be currently in session, as indicated by an @ symbol in front of the meeting 
subject in the list of meetings.

Procedure

Complete one or more of the following actions:
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To Do This

See a list of current meeting 
participants.

Press the Roster softkey.

See the status of each participant. Look at the icon that appears to the left 
of each name. Participants in the 
meeting may display more than one of 
these indicators.

 • A telephone handset icon indicates 
a current participant on the 
telephone.

 • A telephone handset icon with an 
X beside it indicates a participant 
who is muted.

 • A monitor-and-keyboard icon 
indicates a participant who is in 
the web meeting room.

 • No icon indicates an invitee who 
has not joined the meeting

See an updated participant list Press the CurRstr softkey. 

If you do not see a CurRstr softkey, 
press more.

See a list of invited participants who 
may or may not be in the meeting.

Press the Invt softkey.

See participant details. Select the name of the participant.

See who is speaking. Press the CurSpkr softkey

The name of the current speaker 
appears above the softkey labels at the 
bottom of the screen, under the 
participant list. If multiple people are 
speaking, you see will Multiple 
Speakers.
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Related Topics

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22
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Changing Your Cisco Unified 
MeetingPlace Express Preferences

The Cisco Unified MeetingPlace Express system stores your personal and 
meeting settings in your user profile. These profile settings are initially set by 
your system administrator, but you can change some of them later.

This section describes how to change the settings that you have permission to 
change. 

 • Changing Your Personal Profile Settings, page 15-2

 • Changing Both Your Web and Phone Passwords, page 15-2

 • Changing Your Phone Password, page 15-3

 • Specifying Your Preferred Method of Joining Meetings, page 15-4

 • Recording Your Profile Name, page 15-6

 • Assigning a Delegate to Schedule Meetings on Your Behalf, page 15-7

 • Changing Your Time Zone, page 15-7

 • Choosing a Date Format, page 15-8

 • Changing the Entry and Exit Announcements from Your Cisco Unified IP 
Phone, page 15-9
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Changing Your Personal Profile Settings
Before You Begin

 • You must be on the company network.

 • Log in to Cisco Unified MeetingPlace Express as a profiled user.

Procedure

Step 1 Click Profile.

Note The Profile link appears on every screen except for the web meeting room 
screen.

Step 2 Make changes keeping the following in mind:

 • For First Name and Last Name, the maximum length for these fields is 32 
characters.

 • For Language, the language you choose only affects the web and audio 
interfaces after you log in. Before you log in, or if you are a guest, you will 
see and hear the system default language that your system administrator has 
chosen for your Cisco Unified MeetingPlace Express system.

 • If you choose English (US), your clock will be in the 12-hour format. If you 
choose any language other than English (US), your clock will be in the 
24-hour format.

Step 3 Click Update profile.

Changing Both Your Web and Phone Passwords
This topic describes how to change both your web and phone passwords from the 
Web interface.

Before You Begin

Make sure that you are logged in to the system as a profiled user.
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Procedure

Step 1 Click Profile.

Step 2 Click Change Password for the password you want to change.

Note If there is no Change Password button, you cannot change this password.

Step 3 Enter your current password.

Step 4 Enter your new password.

Step 5 Enter your new password again to verify that you entered it correctly.

Step 6 Click Save.

Step 7 Repeat Step 2 through Step 6 for your other password, if desired.

Related Topics

 • Changing Your Phone Password, page 15-3

 • Password Restrictions, page A-1

Changing Your Phone Password
This topic describes how to change only your phone password from your 
touch-tone phone.

Before You Begin

Know your current phone profile number and password.

Procedure

Step 1 Dial the Cisco Unified MeetingPlace Express phone number.

Step 2 Press 2#.

Step 3 Follow the prompts.
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When you are finished, the system begins the prompts again from the beginning 
of the list.

Step 4 Press 3# and follow the prompts to enter your new password.

Related Topics

 • Changing Both Your Web and Phone Passwords, page 15-2

 • Password Restrictions, page A-1

Specifying Your Preferred Method of Joining 
Meetings

Depending on settings made by your system administrator, you may be able to 
choose how you want to join meetings of which you are the owner or to which you 
are invited. The options are:

 • The system calls you automatically when the meeting starts. 

 • You initiate the call process each time you join a meeting.

Note The system can call you at the beginning of meetings to which you have 
been invited only if the scheduler invited you by using the method 
described in the “Inviting Participants by Using the Directory” section on 
page 3-1.

Before You Begin

Make sure that you are logged in to the system as a profiled user. 

Procedure

Step 1 Click Profile.

Step 2 Locate the Method of Attending parameter.
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Note If you cannot find this parameter, you do not have permission to specify 
your preferred method of attending. Skip the remainder of this procedure.

Step 3 Specify how you prefer to join the voice component of your meetings.

 • If your system is configured for video conferencing, this parameter also 
indicates how you prefer to join the video component of your meetings.

 • The Find Me feature applies for meetings that you schedule or start, and 
meetings to which you are invited where the meeting scheduler used the 
directory to specify you as an invitee.

Step 4 If you chose Find Me, enter up to two phone numbers plus an optional pager 
number in the order that you want the system to try. 

 • For each number that you enter, specify the type of number that it is.

 • If the number is connected to a video endpoint, the system will recognize this 
as such when you are connected.

 • Enter each phone number in the same format that you would use to dial that 
number from the telephone on your desk.

 • You can enter only one pager number among the three options as follows: 

Tip If you enter a pager number, we recommend that you enter it as the last 
option in your list since delays in many pager services may result in 
Cisco Unified MeetingPlace Express calling the other numbers in 
addition to the pager number. 

Note When you specify a pager number, you can enter numbers, spaces, and the 
# and * symbols. Cisco Unified MeetingPlace Express ignores all other 
characters.

For This Do This

Direct dial pager Enter the telephone number of the pager.

Non direct dial pager Enter your PIN number for the pager system.
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Step 5 Click Update profile.

Step 6 Click Logoff.

Recording Your Profile Name
All profile users are announced when they first enter a Cisco Unified 
MeetingPlace Express meeting. Use this procedure to record your name so that 
the system can introduce you in future meetings. If you do not record your name, 
the system will prompt you for your name each time it dials out to you to join a 
meeting.

Note You may also be prompted to record your name when you dial in to attend a 
meeting. If this occurs, follow the prompts to record your name.

Before You Begin

Know your phone profile number and password.

Procedure

Step 1 Dial your Cisco Unified MeetingPlace Express telephone number.

Step 2 Press 2#.

Step 3 Follow the prompts to enter your phone profile number and password.

Step 4 Press 2# and follow the prompts.
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Assigning a Delegate to Schedule Meetings on Your 
Behalf

A delegate is a profiled Cisco Unified MeetingPlace Express user who can 
schedule and reschedule meetings on your behalf. Your delegate has the same 
meeting privileges as the meeting scheduler.

As a profiled user, you can have only one delegate. However, a delegate can act 
on behalf of multiple users.

Before You Begin

 • Ask your system administrator who can be your delegate. Not all users can be 
delegates.

 • Make sure that you are logged in to the system as a profiled user. 

Procedure

Step 1 Click Profile.

Step 2 Locate the Assign Delegate parameter.

Step 3 Enter the Cisco Unified MeetingPlace Express username of the person who will 
schedule meetings for you.

Step 4 Click Update Profile.

The next time your delegate logs on and clicks Schedule, your username will 
appear in the Schedule on behalf of list.

Related Topics

 • Scheduling a Meeting on Behalf of Another User, page 2-10

Changing Your Time Zone
You can change the time zone that the system uses to configure your scheduling 
and notification activities. 
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Before You Begin

Make sure that you are logged in to the system as a profiled user.

Procedure

Step 1 Click Profile.

Step 2 Locate the Region field.

Step 3 Choose a region.

 • The region that you choose determines the time zones that you will see.

 • If you plan to choose the “Localtime” time zone, choose Other for Region.

Tip The “Localtime” option is most useful if your company or organization 
has locations in only one time zone. If you want to choose this option, you 
must first choose Other from the Region field.

Step 4 Choose a time zone.

Step 5 Click Update Profile.

Choosing a Date Format
On some systems, you can choose in what format you want dates to appear on 
Cisco Unified MeetingPlace Express web pages.

Before You Begin

 • Make sure that your browser accept cookies. If you delete cookies in your 
browser, you must perform this task again.

 • Open a browser and enter the URL of the Cisco Unified 
MeetingPlace Express server.

Procedure

Step 1 Click Attend.
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Step 2 Choose a language from the bottom of the Attend page:

Note If you do not see any languages at the bottom of the Attend page, your 
system does not offer this feature.

Changing the Entry and Exit Announcements from 
Your Cisco Unified IP Phone

By default, the system announces participants as they enter and exit the meeting. 
You can change these announcement options if you are the meeting scheduler for 
both future meetings and meetings that are in progress.

Before You Begin

 • You must be the meeting owner.

 • You must have Cisco Unified MeetingPlace Express Phone View installed on 
your Cisco Unified IP Phone.

 • Complete the “Viewing Meeting Details On Your Cisco Unified IP Phone” 
section on page 14-6 for the meeting that you want to modify.

To Do This

Use dates in the MM/DD/YYYY 
format.

Choose English (US).

Use dates in the DD/MM/YYYY 
format.

Choose English (UK), English (AU), 
or French (FR).

Use dates in the DD.MM.YYYY 
format.

Choose German.

Use dates in the YYYY-MM-DD 
format.

Choose French (CA).
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Procedure

Step 1 Press the Ancmnts softkey. 

If you do not see Ancmnts, press more.

Step 2 Select the announcement that you want to change.

 • Press 1 to change the entry announcement.

 • Press 2 to change the exit announcement.

Step 3 Choose the announcement style that you want.

 • Press 1 to hear a beep plus the recorded name of the participant who is 
arriving or departing.

 • Press 2 to hear only a beep when a participant arrives or departs.

 • Press 3 to allow participants to arrive or depart silently.

Step 4 Press Close.

Step 5 (Optional) Repeat Step 2 through Step 4 to change the other announcement.
15-10
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



 

User Guide for Cisco Unified
OL-12230-01
C H A P T E R 16

Troubleshooting and Getting Help

This section provides troubleshooting information for common Cisco Unified 
MeetingPlace Express issues. 

 • How to Get Help, page 16-1

 • How to Resolve Log In Problems, page 16-2

 • How to Resolve Schedule Meeting Problems, page 16-4

 • How to Resolve Find Meeting Problems, page 16-7

 • How to Resolve Meeting Notification Problems, page 16-8

 • How to Resolve Password Problems, page 16-9

 • How to Resolve Join Meeting Problems, page 16-10

 • How to Resolve Problems Joining the Web Meeting Room, page 16-12

 • How to Resolve Problems During a Meeting, page 16-14

 • How to Resolve Voice Meeting Problems, page 16-19

 • How to Resolve Video Meeting Problems, page 16-20

 • How to Resolve Problems with Cisco Unified MeetingPlace Express Phone 
View, page 16-22

How to Get Help
 • Finding End-User Documentation, page 16-2

 • Getting Help From a Live Attendant, page 16-2
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Finding End-User Documentation
Documentation for end users of Cisco Unified MeetingPlace Express includes 
online help links in the application, a PDF version of the online help, and Quick 
Start Guides.

For the latest version of all end-user documentation visit the following:

http://www.cisco.com/en/US/products/ps6533/products_user_guide_list.html

Getting Help From a Live Attendant
If your organization has enabled the live attendant feature, you can obtain human 
assistance by telephone.

Before You Begin

 • Know what version of Cisco Unified MeetingPlace Express you are using. 
From the web meeting room, click Help > About Cisco MeetingPlace 
Express.

 • Know what version of the Flash Player you are using. Right-click anywhere 
in the web meeting room and choose About Macromedia Flash Player 7 
then click OK.

Procedure

How to Resolve Log In Problems
 • Cannot Log In Through the Telephone, page 16-3

If Do This

You are in a voice or meeting. Press #, then 0.

You are not in a voice or video 
meeting.

1. Dial the Cisco Unified 
MeetingPlace Express phone 
number. 

2. Press 0, then #.
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 • Cannot Remember My Phone Profile Number, page 16-3

 • Cannot Log In with the Same User Name, page 16-4

 • Cannot See Log In Entries, page 16-4

Cannot Log In Through the Telephone

Problem   I cannot log in to by telephone or by using Cisco Unified 
MeetingPlace Express Phone View on my Cisco Unified IP Phone, or I get an 
error when I log in (“user not recognized” or “profile does not exist.”)

Possible Cause   Your profile is not initialized in the Cisco Unified 
MeetingPlace Express system.

Solution   Go first to your Cisco Unified MeetingPlace Express web URL and log 
in using your username and password to initialize your profile. Then try to log in 
again through your standard or Cisco Unified IP Phone.

Cannot Remember My Phone Profile Number

Problem   I cannot log in to Cisco Unified MeetingPlace Express by telephone 
because I cannot remember my phone profile number.

Solution   

If you know your Web username and password, do the following:

Step 1 Log in to Cisco Unified MeetingPlace Express.

Step 2 Click Profile to see this information.

If you do not know your Web username and password, contact your system 
administrator.
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Cannot Log In with the Same User Name

Problem   I checked Remember Me and I need to log in with a different username.

Solution   

Step 1 Click Log Off from the top of any page.

Step 2 Enter the other username and password. 

Step 3 Uncheck Remember Me.

Step 4 Click Log In.

Related Topics

 • How to Resolve Password Problems, page 16-9

Cannot See Log In Entries

Problem   I checked Remember Me and now when I try to log in, my log-in entries 
get erased and I cannot log in.

Solution   

Step 1 Close the browser window and open a new one.

Step 2 Enter your Cisco Unified MeetingPlace Express URL again.

How to Resolve Schedule Meeting Problems
 • Cannot See the Schedule Link, page 16-5

 • Schedule Meeting Failed Error, page 16-5

 • Cannot Schedule Web Meeting, page 16-6

 • Meeting ID Unavailable, page 16-6
16-4
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 16      Troubleshooting and Getting Help
    How to Resolve Schedule Meeting Problems
 • No Notifications After Updating Microsoft Outlook-Scheduled Meeting, 
page 16-6

Cannot See the Schedule Link

Problem   After entering the URL for my Cisco Unified MeetingPlace Express 
server, I see the Cisco Unified MeetingPlace Express home page but a number of 
links, including Schedule and Find, are missing.

Possible Cause   You are accessing the incorrect URL.

Solution   See the “Cannot See the Find Link” section on page 16-7.

Schedule Meeting Failed Error

Problem   When I try to schedule a meeting, I receive this error: “Schedule meeting 
failed.”

Solution   The system was unable to schedule your meeting for the reason indicated 
on your screen. Use the tips provided to try again to reschedule your meeting. 
Some common reasons for scheduling failure include:

 • You did not enter all the required information.

 • If you specified a meeting ID, it is not unique for the date, time, and duration 
for which you are scheduling the meeting. Try changing the meeting ID.

 • There are not enough resources available on the system at the date and time 
for which you are trying to schedule the meeting. Try choosing a different 
date or time or entering a smaller number of participants, if possible.
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Cannot Schedule Web Meeting

Problem   I am trying to schedule a meeting with both web and voice. When I click 
Schedule, I get a system message asking if I want to schedule an audio-only 
meeting.

Possible Cause   Web meetings are dependent on the availability of web 
licenses. If you try to schedule a meeting when there are not enough web 
licenses available, the system will give you the option to schedule a meeting 
with audio only. 

Solution   If an audio-only meeting is not suitable, try to change the time or date of 
your meeting or consider limiting your list of participants.

Meeting ID Unavailable

Problem   I’m trying to schedule a meeting with a certain meeting ID, but I receive 
an error that the meeting ID is unavailable. I know that there are no other meetings 
that include that meeting ID at the time I am trying to schedule.

Solution   To allow participants to join a meeting shortly before the meeting 
officially begins, and to enable a meeting to be extended if necessary, the actual 
duration that the system reserves for a meeting may be longer than the time that 
the scheduler specifies. Therefore, it may not be possible to schedule two 
meetings that include the same meeting ID very close together. The system 
administrator makes the settings that affect this functionality.

No Notifications After Updating Microsoft Outlook-Scheduled 
Meeting

Problem   I scheduled a meeting using Microsoft Outlook and then modified the 
meeting using another interface, but none of the invitees received an updated 
meeting notification.

Solution   When you schedule a meeting using Microsoft Outlook and then modify 
or delete the meeting using a different interface, such as the web, the system does 
not send out updated notifications.
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How to Resolve Find Meeting Problems
 • Cannot See the Find Link, page 16-7

 • My Meetings Option is Unavailable, page 16-7

 • Meeting is Missing, page 16-7

Cannot See the Find Link

Problem   After entering the URL for my Cisco Unified MeetingPlace Express 
server, I see the Cisco Unified MeetingPlace Express home page but a number of 
links, including Schedule and Find, are missing.

Possible Cause   It is possible that your Cisco Unified MeetingPlace Express 
system is configured for both internal (on the company network) and external 
(Internet) access and that you have accessed the URL for external access.

Solution   Check the URL you entered and make sure that it is directed to go to the 
internal system. This may require you to contact the meeting scheduler or system 
administrator.

My Meetings Option is Unavailable

Problem   I want to find my meetings, but the My Meetings option does not appear 
on the Find Meeting page.

Solution   Make sure that you are logged in with your Cisco Unified 
MeetingPlace Express username and password. 

Meeting is Missing

Problem   The meeting I am looking for does not appear on the list, but I know it 
should be there.

Solution   Try the following solutions:

 • The list of meetings may be too long to fit on one screen. Click the links at 
the bottom to see more meetings in the list.
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 • Make sure you have selected the correct radio button for the type of meeting 
or recording you are trying to find.

 • Check the date range of your search. Be sure you entered the year using four 
digits.

 • The meeting you are searching for may not be a published meeting.

How to Resolve Meeting Notification Problems
 • Scheduler Does Not Receive Meeting Notifications, page 16-8

 • Invitees Do Not Receive Meeting Notifications, page 16-8

Scheduler Does Not Receive Meeting Notifications

Problem   I am not receiving meeting notifications to meetings that I am invited to.

Solution   Try the following solutions:

 • Ensure that your e-mail address is entered correctly in your profile.

 • The meeting scheduler may have entered your e-mail address incorrectly 
when scheduling the meeting. Contact the scheduler to verify your e-mail 
address.

 • Your system administrator may have set options that prevent you from 
receiving some or all meeting notifications. Contact your system 
administrator.

 • Network or other problems may exist. Contact your system administrator.

Invitees Do Not Receive Meeting Notifications

Problem   Some or all of the people I invite to my meetings do not receive 
notifications or updated invitations.

Solution   The system automatically sends updated meeting notifications if any of 
the following changes:

 • Start time
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 • Meeting ID

 • Password

 • List of invitees

No other changes will generate a notification. If you made one of the listed 
changes and still have a notification issue, consider the following:

 • The e-mail addresses of your invitees may not be entered correctly in their 
profiles. Alert invitees who do not receive the notifications, and recommend 
that they check the addresses in their profiles.

 • You may not have entered the e-mail addresses of your invitees correctly 
when you scheduled the meeting. Verify the addresses of invitees who do not 
receive the notifications.

 • Your system administrator may have set options that prevent some recipients 
from receiving some or all meeting notifications, or that prevent e-mail 
notifications from being sent when you schedule or reschedule meetings. 
Contact your system administrator.

Related Topics

 • How to Invite Participants During the Scheduling Process, page 3-1

How to Resolve Password Problems
 • Forgotten Password, page 16-9

 • Password Does Not Work, page 16-10

 • Do Not Have Meeting Password, page 16-10

Forgotten Password

Problem   I cannot remember my password.

Solution   Contact your system administrator.
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Password Does Not Work

Problem   My password does not work.

Solution   Check the following:

 • Passwords are case sensitive. Make sure Caps Lock is not on.

 • Make sure you entered the correct password; every profiled user has two 
passwords: one for logging in via the web and one for logging in via 
telephone.

Related Topics

 • Your User IDs and Passwords, page 1-2

Do Not Have Meeting Password

Problem   I do not have the meeting password.

Solution   Check to see if the password is specified in an e-mailed meeting 
invitation. If it is not, or you did not receive a meeting notifications, contact the 
meeting scheduler.

How to Resolve Join Meeting Problems
 • Meeting Still Available 30 Minutes After End, page 16-11

 • Error: Meeting ID Not Found, page 16-11

 • Error: No System Resources Available, page 16-11

 • System Does Not Call Me for Meetings, page 16-12
16-10
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Chapter 16      Troubleshooting and Getting Help
    How to Resolve Join Meeting Problems
Meeting Still Available 30 Minutes After End

Problem   I scheduled a meeting to last for one hour. No one attended, but the 
meeting is still available 30 minutes after the meeting was supposed to end.

Possible Cause   The system is configured to release ports for a meeting 
30 minutes after the meeting is scheduled to end.

Solution   Do nothing. This is normal behavior. If you know that the meeting will 
be unattended, make sure that you cancel the meeting before it starts to release the 
scheduled ports.

Error: Meeting ID Not Found

Problem   I am on the Cisco Unified MeetingPlace Express web page. When I enter 
the meeting ID that I have been given, I get an error message: Meeting ID not 
found.

Possible Cause   It is possible that your Cisco Unified MeetingPlace Express 
system is configured for both internal (on the company network) and external 
(Internet) access and that you have accessed the URL for external access.

Solution   Check the URL you entered and make sure that it is directed to go to the 
internal system. This may require you to contact the meeting scheduler or system 
administrator. If you know the URL for the internal system, try using your 
meeting ID on that web site.

Error: No System Resources Available

Problem   I am trying to join a web meeting, but see an error message similar to “No 
system resources available for operation.”

Possible Cause   Your system does not have enough web conferencing licenses 
available. 

Solution   Contact your system administrator to have more web conferencing 
licenses added to your system or wait until some licenses become available (such 
as when other end users have finished their web meetings).
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System Does Not Call Me for Meetings 

Problem   The system does not automatically call me in to the meeting when it 
should.

Possible Cause   There may be a problem with your profile configuration 
regarding how the system finds you for a meeting.

Solution   Contact your system administrator to review your profile configuration.

How to Resolve Problems Joining the Web Meeting 
Room 

 • Cannot Join Web Meeting Room, page 16-12

 • Repeated Prompts to Download Adobe Flash Player, page 16-14

 • Cannot Join a Locked Meeting, page 16-14

Cannot Join Web Meeting Room

Problem   I cannot join the web meeting room.

Possible Cause   Unknown.

Solution   Try the following solutions:

 • Run the browser test to be sure your computer and software are compatible 
with the web meeting room. For information, see the “Preparing to Join a 
Meeting for the First Time” section on page 5-3.

 • If you downloaded the correct version of the Adobe Flash Player during the 
browser test, then after it is installed, close all browser windows, open a new 
browser window, and try again to connect to the meeting.

 • Verify that your internet connection is working properly by verifying that you 
can connect successfully to other web sites.

 • Disable any pop-up blockers or unblock the Cisco Unified 
MeetingPlace Express URL to access the meeting.
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 • Try clearing the cache of your browser.

 • Try connecting from another computer.

 • There may be issues on the side of the meeting presenter or an issue with the 
event.

 • Your system may not have enough capacity to accommodate you. You can try 
again later to join the web portion of your meeting and see if capacity has 
become available.

Possible Cause   You are trying to join a meeting through the internal 
Cisco Unified MeetingPlace Express server when you are off the company 
network.

Solution   Check the e-mail notification you received. If the meeting was scheduled 
to permit participants who are not on the company network, there should be a 
Meeting URL link for an external system. Click that link to join your meeting.

Possible Cause   You are trying to access the meeting from behind a proxy 
server and you are using Microsoft Internet Explorer.

Solution   

Step 1 Open a Microsoft Internet Explorer browser window.

Step 2 Choose Tools > Internet Options > Advanced.

Step 3 Check Use HTTP 1.1 through proxy connections and click OK. 

Step 4 Close all browser windows then re-open them.

Step 5 Try again to connect to the meeting.

Possible Cause   You do not have the correct version of the Flash Player and you 
cannot obtain it from the Browser Test.

Solution   

Step 1 Open a web browser and go to 
http://www.macromedia.com/shockwave/download/download.cgi?P1_Prod_Vers
ion=ShockwaveFlash.

Step 2 Click Install Now.
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Step 3 After the player is installed, close all browser windows, then re-open them.

Step 4 Try again to connect to the meeting.

What to Do Next

If you still cannot join the web meeting room, contact your Cisco Unified 
MeetingPlace Express system administrator.

Repeated Prompts to Download Adobe Flash Player

Problem   I have already downloaded the Adobe Flash Player and Cisco Unified 
MeetingPlace Express is prompting me to download it again.

Solution   If you have multiple browsers installed on your computer, the system 
will prompt you to download the Adobe Flash Player the first time you use each 
browser to join the web meeting room.

Cannot Join a Locked Meeting

Problem   I have requested to join a locked meeting but nothing is happening. I 
know that I am welcome in the meeting.

Solution   See the “Requesting Entry to a Locked Meeting” section on page 5-11. 

How to Resolve Problems During a Meeting
 • Unstable Web Meeting Room, page 16-15

 • Black Screen Appears, page 16-15

 • Screen Objects Missing, page 16-16

 • Volume Controls Are Disabled, page 16-16

 • Permissions Are Incorrect, page 16-16

 • Participant Listed Twice, page 16-17

 • Cannot Install Cisco Unified MeetingPlace Express Add-in, page 16-17
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 • Sharing Problems, page 16-18

 • Blue Box Appears, page 16-18

Unstable Web Meeting Room

Problem   My web meeting room is breaking up or redrawing very slowly, or does 
not stay connected.

Solution   Try the following solutions:

 • Make sure that you are not using any other applications or processes that are 
network-intensive. For example, do not download video files from the 
Internet while you are attending a meeting.

 • Click Help > Connection Status to verify that your connection is adequate. 
If not, try choosing a lower bandwidth.

 • If you are attending via modem, make sure that you are not doing any other 
activity that uses the available modem bandwidth.

 • If you continue to experience network connection problems, ask a meeting 
moderator to reduce the speed of the web meeting room connection.

Related Topics

 • Changing Your Connection Speed to the Web Meeting Room, page 13-2

 • Optimizing the Web Meeting Room Bandwidth, page 13-6

Black Screen Appears

Problem   Sometimes a black screen appears when someone is sharing.

Solution   This is normal. The Share pod area is black while the presenter selects 
the content to share.
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Screen Objects Missing

Problem   Buttons and options are missing from my view of the web meeting room. 

Solution   You may not have the permission level that you expect to have. Users 
with audience or presenter permissions have fewer privileges in the web meeting 
room than those with moderator permissions. You can send a message to a 
moderator, or ask in the meeting, to request a different permission level.

Volume Controls Are Disabled

Problem   Volume and mute controls in the participant list are dimmed.

Solution   Whether the participant is yourself or another participant whose volume 
you are trying to change:

 • If the participant has not already joined via telephone, voice options are not 
available when the name of that participant is selected.

 • If the participant has joined the web and voice meetings separately, the 
participant will be listed twice unless a moderator has merged the instances. 
The voice controls will be dimmed if you select the instance that has joined 
the web meeting. To modify voice options, first merge the two instances, or 
select the instance that has joined the voice meeting.

 • If you have selected multiple participants in the list, if any of the selected 
participants appears in the list as a web-only participant, deselect that entry 
in the list.

Related Topics

 • Merging Two Instances of a Participant in the Participant List, page 8-6

Permissions Are Incorrect

Problem   I am a profiled user but I enter the web meeting room with only presenter 
permissions. I should have moderator privileges.

Solution   Make sure that you logged in as a profiled user. If you enter as a guest 
user, you will have only presenter permissions.
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Participant Listed Twice

Problem   A participant appears twice in the participant list.

Possible Cause   This can be caused by one of the following:

 • A participant has dialed in to join the meeting instead of having the system 
dial out to him. 

 • A guest user has dialed in to the meeting, been renamed in the participant list, 
then left the conference. If the guest dials in again, the person enters as a 
separate entity.

 • A participant has entered the voice/video and web meetings separately, 
entering one instance as a profiled user (by logging in), and the other as a 
guest (without logging in). Or the participant has entered both instances as a 
guest.

Solution   If you have moderator permissions, merge the two entries that are known 
to be the same participant.

Related Topics

 • Merging Two Instances of a Participant in the Participant List, page 8-6

Cannot Install Cisco Unified MeetingPlace Express Add-in

Problem   I get an error when I try to download the Cisco Unified 
MeetingPlace Express Add-in from inside the web meeting room.

Possible Cause   You may lack the appropriate permissions to install an 
application on a local hard drive or some antivirus software is preventing the 
installation of an executable file on a local hard drive.

Solution   Contact your system administrator to assist you with your permissions or 
antivirus software configuration.

Related Topics

 • Preparing to Share Content, page 9-2.
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Sharing Problems

Problem   I cannot share my screen or a document.

Solution   Try the following solutions:

 • Ensure that you are a presenter or moderator by checking the participant list. 
Roll your mouse over the icons to the left of your name to see your permission 
level.

 • Make sure that have installed the Cisco Unified MeetingPlace Express 
Add-in.

 • If you are using Microsoft Internet Explorer, be sure that you have the latest 
version of Internet Explorer installed. If it is not possible to update, and you 
have an older version such as Internet Explorer 5, make sure the browser 
certification is current. Check the Microsoft Windows Update web site, for 
Root Certification Update under the operating system section.

Related Topics

 • Preparing to Share Content, page 9-2

Blue Box Appears

Problem   I am sharing my screen, but participants see only a blue box with a 
checked pattern.

Possible Cause   You are hiding the application that you want to share with 
other applications or documents on your screen.

Solution   If you are sharing one application, rather than the entire screen, that 
application must be visible on your screen at all times. Click the document or 
application that you want to share in order to bring it to the front for sharing.

Related Topics

 • Sharing a Screen During a Meeting, page 9-3
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How to Resolve Voice Meeting Problems
 • Difficulty Hearing Participants, page 16-19

 • Excessive Background Noise, page 16-19

 • Names Missing from Announcements, page 16-20

 • Phone Key Commands Do Not Work, page 16-20

Difficulty Hearing Participants

Problem   Some voices are very low and no one can hear them.

Solution   Increase the input volume of those participants. 

Related Topics

 • Changing the Volume of Individual Participants, page 8-4

Excessive Background Noise

Problem   There is a lot of unwanted noise in the meeting.

Solution   

Step 1 Determine the source of the noise.

a. Select all participants and mute them.

b. Unmute them one by one until you hear the unwanted noise. 

Step 2 Mute the offending line or reduce the input volume of those participants. 

Related Topics

 • Muting and Unmuting Participants from the Web Meeting Room, page 8-2

 • Changing the Volume of Individual Participants, page 8-4
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Names Missing from Announcements

Problem   I do not hear the names of some participants when they enter or exit the 
meeting, even though the announcement options are set to Beep + Name.

Solution   The name of the participant was probably not recorded when the 
participant logged in to the system. All participants are prompted to record their 
name when they join a meeting via voice. If you require that all participants in the 
voice portion of your meeting identify themselves by name, tell the participants 
that they must record their names when they hear the prompt.

Phone Key Commands Do Not Work

Problem   I am trying to use telephone commands, but nothing happens when I 
press the number buttons.

Possible Cause   If you have been using Cisco Unified MeetingPlace Express 
Phone View on your Cisco Unified IP Phone and information about meetings 
or participants is visible on the screen of the phone, you cannot enter 
commands from the telephone keypad. 

Solution   Read the “Tips for Using Cisco Unified MeetingPlace Express with Your 
Cisco Unified IP Phone” section on page 14-2.

How to Resolve Video Meeting Problems
 • Video Camera Does Not Launch, page 16-21

 • Cannot See Image When Using Cisco Unified Video Advantage, page 16-21

 • Time Delay When Switching Between Active Speakers, page 16-21
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Video Camera Does Not Launch

Problem   I am calling through a phone that is connected to my video endpoint, but 
my video window does not launch.

Possible Cause   Your video endpoint and phone are not configured properly.

Solution   Contact your system administrator to verify your configuration.

Possible Cause   The meeting is not scheduled as a video meeting.

Solution   Do nothing. Video will not launch if the meeting was not scheduled as a 
video meeting.

Cannot See Image When Using Cisco Unified Video Advantage

Problem   I am using Cisco Unified Video Advantage as my video endpoint. My 
video window launched, but I cannot see an image. 

Possible Cause   You changed the video bit rate on the Cisco Unified 
Video Advantage console. If the bit rate falls lower than what is supported by 
the meeting, you will not see video.

Solution   Try the following:

Step 1 Open your Cisco Unified Video Advantage console.

Step 2 Choose Settings > Video Quality.

Step 3 Move the slider up to the minimum bit rate for the meeting.

Step 4 Close the console.

Time Delay When Switching Between Active Speakers

Problem   I see a delay of a few seconds whenever the video display switches from 
one active speaker to another.

Solution   Do nothing. This is expected behavior.
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How to Resolve Problems with Cisco Unified 
MeetingPlace Express Phone View

 • Log In Issue, page 16-22

 • Session Times Out, page 16-22

 • Cannot Access In-Session Features, page 16-23

 • Softkey Button Changes, page 16-23

Log In Issue

Problem   Logging into the Cisco Unified IP Phone does not work, or I get an error 
(“user not recognized” or “profile does not exist.”)

Solution   See the “Cannot Log In Through the Telephone” section on page 16-3. 

Session Times Out

Problem   My session times out while I am using Cisco Unified 
MeetingPlace Express Phone View on my Cisco Unified IP Phone.

Solution   Press the Services button on your Cisco Unified IP Phone twice. 
Depending on the model of your phone, this button may be a globe icon or labeled 
Services. 

Related Topics

 • Setting Up Cisco Unified MeetingPlace Express Phone View, page 14-2
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Cannot Access In-Session Features

Problem   I have joined the meeting by telephone, but I cannot access in-session 
features such as the list of current participants or the mute feature.

Possible Cause   You can access in-session features only if you have joined the 
meeting as a profiled user from your Cisco Unified IP Phone. If you joined 
the meeting by dialing in and entering as a guest (you did not enter your 
phone profile number and password), the service has no way to associate the 
call with you.

Solution   Hang up and join the meeting again as a profiled user.

Softkey Button Changes

Problem   After I press a softkey on my Cisco IP Communicator or Cisco Unified 
IP Phone Model 7970 phone, the button changes for a few moments. 

Solution   This is normal. The button will return to normal when the system finishes 
processing your request.
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Reference

 • Password Restrictions, page A-1

Password Restrictions

Password Type Restrictions

Password that is used to log in to 
Cisco Unified MeetingPlace Express 
through the Web.

This password is associated with your 
username.

 • Can contain up to 17 numbers and 
letters.

 • Is case-sensitive.

 • Cannot be blank.

 • Must be the minimum length set 
by your system administrator. By 
default, the minimum length is five 
characters.
A-1
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    Password Restrictions
Related Topics

 • Changing Both Your Web and Phone Passwords, page 15-2

 • Changing Your Phone Password, page 15-3

 • How to Schedule a Meeting, page 2-6

Password that is used to log in to 
Cisco Unified MeetingPlace Express 
through a telephone or by using 
Cisco Unified MeetingPlace Express 
Phone View on your Cisco Unified IP 
Phone

This password is associated with your 
phone profile number and is also 
referred to as your PIN.

 • Can contain only numbers.

 • Cannot be more than 17 characters 
long.

 • Cannot be blank.

 • Must be the minimum length set 
by your system administrator. By 
default, the minimum password 
length is five characters.

Meeting password.

This password is specified by the 
meeting scheduler when scheduling 
the meeting.

 • Can include letters or numbers or 
both.

Password Type Restrictions
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attendant A person to whom the Cisco Unified MeetingPlace Express system 
administrator has given privileges to reschedule all meetings and end all 
meetings via the Meeting Details web page. Attendants can perform limited 
system administrator tasks, such as viewing alarms and reports, in the 
Administration Center.

audience One of three permission levels in a web meeting room. A person who has 
audience privileges has limited permissions during a meeting. In the full meeting 
room, audience members can also view shared content, chat messages, and 
notes, and send chat messages. Moderators and presenters can restrict audience 
chat messages.

No participant has this permission level by default. However, moderators can 
demote participants to this permission level during a meeting to restrict the 
activity of those participants.

B

billing code The code your company or department uses if it performs bill-backs.
GL-1
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breakout session A voice-only meeting within a meeting. This feature is useful if you want to 
meet privately with some of the other participants in the meeting, for example if 
you want to take a discussion offline and then return to the main meeting with a 
decision.

A meeting can have up to nine simultaneous breakout sessions.

browser test A test that you should run before you join the web meeting room, especially the 
first time you plan to join a meeting. Verifies that your computer can properly 
display the web meeting room.

C

Chat pod A pod in the full meeting room that allows meeting participants to send messages 
to one another.

Cisco Unified 

MeetingPlace 

Express Phone View

A Cisco Unified IP Phone has a screen and buttons that standard telephones do 
not have. If you have a Cisco Unified IP Phone and your system administrator 
has configured Cisco Unified MeetingPlace Express Phone View, you can use 
buttons and options on the screen of your Cisco Unified IP Phone to start a 
reservationless meeting, join meetings, view meeting details, and perform some 
in-meeting functions.

continuous meeting A permanent meeting that is always in session, even after everyone leaves and 
hangs up.

D

delegate A person who can schedule and reschedule meetings on your behalf. The system 
administrator determines who can be a delegate.

dial out When Cisco Unified MeetingPlace Express calls you. After you answer the call, 
you respond to voice prompts that you hear.

duration How long your meeting lasts. The default maximum meeting length is 24 hours 
for voice meetings and 12 hours for web meetings. The minimum meeting length 
is 2 minutes.
GL-2
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



   
Glossary
E

Entry 

Announcement

A scheduling parameter. Allows you to determine how participants are 
announced when they enter this meeting.

You can change this option during a meeting.

Exit Announcement A scheduling parameter. Allows you to determine how participants are 
announced when they leave this meeting.

You can change this option during a meeting.

F

full meeting room A web meeting room configuration. The full meeting room displays the 
participant list along with the Share pod, where you can share and annotate 
content on your computer, the Chat pod and the Note pod. Specific features 
available to each participant depend on the permission level of that participant.

G

guest user  A user who does not have a Cisco Unified MeetingPlace Express profile, or who 
does not log in to a meeting or the Cisco Unified MeetingPlace Express system 
with their Cisco Unified MeetingPlace Express username (or phone profile 
number) and password.

I

immediate meeting  A meeting that is scheduled to start immediately. Any profiled user can schedule 
immediate meetings via a web browser. Compare to reservationless meeting.
GL-3
User Guide for Cisco Unified MeetingPlace Express Release 2.x

OL-12230-01



Glossary
M

meeting ID The number that uniquely identifies a meeting for the date, time, and duration 
for which it is scheduled. Can be up to 17 alphanumeric characters long and 
cannot contain spaces.

If you are scheduling a recurring meeting, this value must be available as a 
unique meeting ID for all recurrences of the meeting.

moderator One of three permission levels in the Cisco Unified MeetingPlace Express web 
meeting room. 

A participant who has moderator privileges can perform all activities in the web 
meeting room. By default, all participants who enter a meeting with their 
Cisco Unified MeetingPlace Express profile (that is, who enter their 
Cisco Unified MeetingPlace Express username and password) have moderator 
privileges.

N

Note pod A pod in the full meeting room where meeting participants can write notes that 
will be seen by everyone in the meeting.

notification An e-mailed invitation that you receive when someone invites you to a meeting. 
You also receive an invitation for meetings that you schedule. Invitations are not 
sent for eservationless meetings.

If a meeting includes the full meeting room, the term “notification” can also 
refer to the pop-up notifier that a participant sees if he is viewing the Share pod 
full screen, has enabled chat notifications, and receives a text message.
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outdial When Cisco Unified MeetingPlace Express calls you (or another person) at 
either the telephone number in your profile or at a telephone number that you 
provide when you make the request.

Depending on settings that the system administrator makes, not all users may 
have Cisco Unified MeetingPlace Express dial out to them.

owner Usually the owner of a meeting is the meeting scheduler. However, if a delegate 
schedules a meeting on behalf of another user, that user is the owner of the 
meeting, even though the delegate is the meeting scheduler.

P

participant list The list of participants that appears in the web meeting room. On the 
Cisco Unified IP Phone, similar information is called the roster. Participant list 
also refers to a web meeting room configuration for meetings that do not require 
participants to share content, chat, or create notes.

Participant List pod A section of the web meeting room that displays the list of participants along 
with access to several user features.

permission level Determines the privileges that each meeting participant has inside the web 
meeting room only (but not in other areas of Cisco Unified MeetingPlace 
Express.) Permission levels are: audience, presenter, and moderator.

phone profile 

number

The user ID that uniquely identifies you when you log in via telephone. 

pod One of the following four functional areas in the web meeting room: Participant 
List pod (full meeting room and Participant List only configurations); Chat pod 
(full meeting room configuration only); Note pod (full meeting room 
configuration only); Share pod (full meeting room and share-only meeting room 
configurations).
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presenter One of three permission levels in the web meeting room. A participant with 
presenter permissions has more privileges than a participant with audience 
permission, but fewer privileges than a participant with moderator permissions. 
In the full meeting room, presenters can control shared content, post notes, 
control the chat feature, and use all features that are available to participants with 
audience permissions.

In a share-only meeting initiated by Cisco Unified Personal Communicator, 
presenters can share content, control their personal viewing experience, and 
view shared content.

Guest users enter meetings with presenter permissions by default. The presenter 
permission level has no practical use in Cisco Unified MeetingPlace Express 
meetings that do not include sharing functionality.

profile Some, most, or all people in an organization have a Cisco Unified MeetingPlace 
Express profile. This profile contains information such as a user ID and 
password, contact information, and privileges.

When you log in to Cisco Unified MeetingPlace Express using the user ID and 
password that are defined in your profile, you have access to all of the functions 
that are available to profiled users, minus any functions to which your system 
administrator has restricted your access.

profiled user A person who has a profile defined in Cisco Unified MeetingPlace Express.

published meeting A meeting that is publicly available when users perform a search on the Find 
Meetings page. If a meeting is not “published” its meeting details are only 
available for the meeting scheduler, the meeting owner (if the scheduler was a 
delegate), any attendants, system administrators, and meeting invitees.

By default, all reservationless meetings are published meetings.

Note Anyone can find any meeting, even if the meeting is not published, if 
they know the meeting ID.
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R

recurring meeting A series of meetings that occurs according to a regular pattern; for example, 
daily or every third week.

reservationless 

meeting

A meeting that you do not schedule in advance.

reservationless 

meeting ID

The meeting ID of a reservationless meeting is always the same as the phone 
profile number of the meeting owner.

roster The list of participants that Cisco Unified MeetingPlace Express Phone View 
displays on your Cisco Unified IP Phone.

S

Schedule meeting 

on behalf of

A scheduling parameter. Contains the usernames of all of the people who have 
identified you as a delegate, or for whom the system administrator has 
designated you as delegate. Only appears if you are authorized to schedule 
meetings for another user.

scheduler The person who schedules the meeting. Usually, the meeting scheduler is the 
meeting owner; however, if a delegate schedules the meeting on behalf of 
another user, the delegate is the scheduler.

screen sharing When a presenter or moderator demonstrates an application, or displays a 
document or desktop to all participants in a web meeting room.

Share pod A pod in the full meeting room or share-only meeting room where meeting 
participants can share an application or display a document or desktop to all 
participants.

Annotations on shared content appear on a transparent overlay. This means that 
the original files are not altered during the annotation process.

share-only meeting A Cisco Unified MeetingPlace Express web meeting launched by a user from 
their Cisco Unified Personal Communicator application.
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softkey On a Cisco Unified IP Phone, one of the buttons directly below the screen of the 
phone. The function of each softkey appears at the bottom of the screen, just 
above each button. The function of each key can change depending on the screen 
that you are viewing.

System Manager A system administrator of your Cisco Unified MeetingPlace Express system.

U

user class Determines what a profiled user can see and do in the Cisco Unified 
MeetingPlace Express system and when attending meetings. User classes are: 
profiled user, guest user, delegate, attendant, and System Manager.

user ID Every profiled user has two user IDs: a phone profile number and a web 
username.

username The name that you use to log in to Cisco Unified MeetingPlace Express via a 
web browser.

V

video meeting The part of a meeting that you participate in via your video endpoint. Audio and 
video are merged for a participant who uses a video endpoint. A meeting usually 
also has an associated web meeting.

video type A video type describes the video characteristics that will be used for the meeting. 
Be sure to select a video type that is compatible with video endpoints that will 
be calling into the meeting. The video type  controls the video compression 
method (codec, H.263 or h.264) that will be used for the meeting, as well as the 
minimum and maximum video bit rate that will be allowed. 

The video types you may select and their characteristics are configured by the 
system administrator.

voice meeting The part of a meeting that you participate in via your telephone. A meeting 
usually also has an associated web meeting.
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W

waiting room When meeting participants arrive in a reservationless meeting before the 
meeting begins, they must wait in a waiting room until the meeting starts.

web meeting The part of a meeting that is visible in the web meeting room. A web meeting 
usually has an associated voice meeting and video meeting.

web meeting room The part of a Cisco Unified MeetingPlace Express meeting that you see when 
you join a meeting through a web browser.
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